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Conventions
The following icons are used in this guide, depending on the content described.

The following conventions are used in this guide.

 Microsoft Windows Operating System is referred to as "Windows" in this guide.
 In this guide, "Computer" or "PC" refers to a personal computer.

Provides important information that you should know and check before using or operating the
product.

Indicates supplemental information useful for operation.

Indicates references to other chapters and manuals.

"   " Indicates messages, file names, folder names, entered values, entered examples, and emphasized
content. It also indicates cross-references within this guide.
e.g. "xxx" is displayed.

[   ] Indicates the name of a setting item displayed on the computer screen. Also, it indicates the name of
a window, menu, dialog box, tab, or button displayed.
e.g. Click [OK].

{   } Indicates values such as a drive name or user name that change when the operation is executed.
e.g. "{model name}:{serial number}({IP address or host name})" for the target device is displayed.

> Indicates a path to proceed to a certain item within a procedure on a menu or a Web page.
e.g. Select [Start]＞ [Program].

Important

Note

See
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1Overview of Device Setup

About Device Setup
This section explains the main characteristics and features of Device Setup.
Device Setup is a program that enables you to know the status of multi-function machine and device on 
the network, so as to change setting or restrict usage accordingly. The device management features 
provided by Device Setup are called Services.
Device Setup provides the following services:

Device settings file Collect job history
Export

Display in graph

Analyze job log

"Creating Job Flow Sheet" (P.13)

"Setting Basic Information of Devices" (P.14)

"Creating Mailbox" (P.14)

"Creating Address Book" (P.15) or "Creating 
Contact Information" (P.16)

Import

Setting Import

A d m i n i s t r a t o r ’s
computer

"Creating Fax Group" (P.15) or "Creating Address 
Group" (P.16)

"Checking / Restricting Use of Devices" (P.12)

"Creating Internet Fax Comment" (P.16)

"Creating Folder Selector" (P.17)

Services provided by Device Setup 
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Device Setup Characteristics
The characteristics of Device Setup are as follows:
 Listing Devices/Configuring Devices All at Once
 Changing Configuration Offline
 Creating Device Setup Plan
 Creating Usage Restrictions, Mailboxes, Address Book/Contact Information, Job Flow Sheets, etc. All 

at Once

Listing Devices/Configuring Devices All at Once
Typically, the device control panel is used to configure services provided by the device.
Device Setup provides a user interface to view a list of devices, and manage and configure their settings 
on your PC.
You can view a list of attributes from multiple devices, or apply settings for individual Device Setup 
services to multiple devices all at once. This helps to reduce administrative workload.
An attribute is a piece of information that a device has. Specially, a device's settings (e.g. enabled port 
or information about administrator) and registered data (e.g. user, mailbox, Address Book/Contact 
Information, or job flow sheet) are all attributes of the device.

Select  and configure mul t ip le
devices all at once
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Changing Configuration Offline
Device Setup communicates with devices (online) only when it retrieves current settings from them or 
it applies edited information to them, Device Setup does not communication with devices when it is 
being worked with. You can work with Device Setup even when other users are operating the devices. 
This helps to reduce the load on devices and network.

Creating Device Setup Plan
With Device Setup, a dummy (imaginary) device's settings can be created and exported to a file, even if 
it does not exist in your environment.
By using this feature, you can apply settings to all devices at once, even when devices have been moved, 
for example, due to a relocation of business premises or organization sites.

Offline

Configure and save within Device Setup

Add a dummy device, and configure/save
the device' settings in Device Setup



1 　Overview of Device Setup

11

Creating Information for Individual Services All at Once
You can edit multiple information elements, such as user details, user permissions, mailboxes, address 
book/contact information, fax group/address group, folder selectors, fax comments, and job flow sheets, 
and set them to a single device all at once.
This is done by using “Device Setup InputTool” which is in Microsoft Excel format. First create a batch 
input file using “Device Setup InputTool,” then import the file using Device Setup.

See
For information on batch creation processes, refer to "Creating Usage Restrictions All at Once" (P.114), 
"Creating Multiple Mailboxes All at Once" (P.49), "Creating the Contact Information All at Once" (P.79), 
"Creating Multiple Recipients All at Once" (P.61), and "Creating Job Flow Sheets All at Once" (P.142).

Device Setup Features
The main features of Device Setup are as follows:
 Check / restrict use of devices
 Create job flow sheets
 Set basic information on devices
 Create mailbox, address book/contact information, fax group/address group, fax comment, folder 

selector

Note
Supported services vary depending on the device type. For more information, refer to Readme.txt.

Device Setup

Batch Input File

Administrator’s
computer

Device Setup Input Tool

Import the data using Device Setup

Apply the data to a device

Input setting information, and then export
the data.
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Checking / Restricting Use of Devices
Device Setup provides services for checking / restricting use of devices.

Access Permissions Service
Access Permissions service is a service for configuring the login setup / accounting mode of a device. It 
can be used to check the number of pages copied in color and in black and white, separately, on the 
device, or restrict access to the color copy or color print feature to certain users. It can also be used to 
set the sender's IP addresses that are allowed to communicate with the device, or the sender's e-mail 
domains that are allowed or denied to communication with the device.
In addition, “Device Setup InputTool” allows you to create user details and user access permissions data 
for multiple users all at once, and set them to Device Setup.

Job Log Analysis Service
Job Log Analysis service is a service for collecting job history from devices to create charts or lists of the 
usage.

Set Access Permissions data using Device Setup

Batch input file

Setting

Export

･ Login data
･ User details
･ E-mail access data

Import

Input access permissions data using Device Setup InputTool.

Retrieve

Setting

Batch input information
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Note
Our ApeosWare Management Suite allows you to manage and collect more detailed device data.

Creating Job Flow Sheet
Job Flow Sheet describes the flow of processing (jobs) in the device, such as scanning, printing, sending 
e-mail, faxing, and file transferring.
Job Flow Sheet service creates, edits, copies, and deletes job flow sheet; changes the owner of job flow 
sheet; as well as exports / imports job flow sheet.
In addition, “Device Setup InputTool” allows you to create multiple Job Flow Sheet settings all at once, 
and set them to Device Setup.

Collect job log from a device with Device Setup

Display collected job log in a graph 

Set Job Flow Sheet service using Device Setup

Batch Input File

Setting

Export

Import

Input Job flow sheet settings using Device Setup InputTool.

Retrieve

SettingBatch input information

Job flow sheet setting
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Setting Basic Information of Devices
Basic Information service is a service for setting product information, the port to be enabled, the 
duration of time before the device enters power save mode, the protocol to be used, and the internal 
time of the device.
Many of the attributes you set with Basic Information service are typically common to many devices, so 
you can set those attributes all at once by selecting multiple devices. This helps you to set multiple 
devices efficiently.

Creating Mailbox
Mailbox is a storage area the device has for storing scanned and faxed documents.
Mailbox service is a service for creating, changing the settings of, copying or deleting mailboxes, and 
reflect them in the device.
In addition, “Device Setup InputTool” allows you to create multiple mailboxes all at once, and set them 
to Device Setup. 

Expand [Basic Information] in Device Setup, and select multiple devices in List view

Select and configure multiple devices all at once

･ Product Information
･ Set port to be enabled
･ Time before the device enters

power save mode
･ Protocols
･ Device time

Set mailbox data using Device Setup

Batch Input File

Setting

Export

･ Create mailbox
･ Change settings
･ Copy mailbox
･ Delete mailbox

Import

Input mailbox data using Device Setup InputTool

Retrieve

Setting
Batch input information
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Creating Address Book
Address Book service is a service for managing the address book of the device. With the service, you can 
set address numbers and recipients using Device Setup, and reflect them in the device. You can also 
import and edit the address book set in the device using Device Setup, or set it to another device.
In addition, “Device Setup InputTool” allows you to create multiple recipients all at once, and set them 
to Device Setup.

Creating Fax Group
Fax group service is a service for managing fax group for the device. Up to 20 speed dial numbers can 
be registered per fax group. Up to 50 fax groups can be created.
You can also import and edit the fax group set in the device using Device Setup, or set it to another 
device.
In addition, “Device Setup InputTool” allows you to create multiple fax groups all at once, and set them 
to Device Setup.

Create address book using Device Setup

Batch Input File

Setting

Export

Input recipient data using Device Setup InputTool.

Retrieve

Setting

･ Fax number
･ Mail recipients
･ Server name / Internet 

Fax recipient

Batch input information
Import
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Creating Contact Information
Contact Information service is a service for managing the contact information of the device. With the 
service, you can set recipient names using Device Setup, and reflect them in the device. You can also 
import and edit the contact information set in the device using Device Setup, or set it to another device.
In addition, “Device Setup InputTool” allows you to create multiple recipients all at once, and set them 
to Device Setup.

Creating Address Group
Address Group service is a service for managing address groups for the device.
The number of address groups that can be created is up to 250 fax groups and up to 250 mail groups.
The maximum number of members that can be registered in an address group is 600 in a fax group and 
100 in a mail group.
You can also import and edit the address group set in the device using Device Setup, or set it to another 
device.
In addition, “Device Setup InputTool” allows you to create multiple address groups all at once, and set 
them to Device Setup.

Creating Internet Fax Comment
You can register up to 50 comments to be used in cover page for Internet Fax.
In addition, “Device Setup InputTool” allows you to create multiple comments all at once, and set them 
to Device Setup.

Create Contact Information using Device Setup

Batch Input File

Setting

Export

Input recipient data using Device Setup InputTool

Retrieve

Setting

･ Fax number
･ Mail recipients
･ Server name / 

Internet Fax recipient

Batch input information

Import
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Creating Folder Selector
Folder Selector service is a service for distributing received fax documents to mailboxes based on the 
type of the sender's telephone number and the telephone number.
The remote ID is G3ID noticed from the other end.
In addition, “Device Setup InputTool” allows you to create multiple folder selectors all at once, and set 
them to Device Setup.

Operation Flow
This section explains the flow of Device Setup operations.

Check requirements （P.19）

Installation / Activation
Install Device Setup （P.23）

Start Device Setup （P.28）

The following operations can be performed as needed.

Register devices with Device Setup （P.32）

Set basic information（P.40）

Reflect settings in devices（P.102）

Device Registration
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Create usage restrictions （P.107）

Set mailboxes（P.46）

Set Address Book（P.53） or Set Contact Information（P.71）

Set Fax Group（P.65） or Address Group（P.81）

Set fax comments（P.88）

Set folder selectors（P.95）

Reflect settings in devices（P.102）

Reflect settings in devices（P.102）

Collect job log from devices（P.121）

Display graph or list（P.122）

Create job flow sheets（P.124）

Reflect settings in devices（P.102）

Setting Services

Registering Job Flow

Check usage restriction 
and device usage

Registering Job Flow Sheet
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2Before Installing Device Setup

 Required System Environment
For the latest operating environment, please visit our official website.

Network Environment
This section explains the network environment where Device Setup can connect to devices. 
 Intranet environment

Note
Environment where a device connects to a PC directly via serial, parallel, or USB, and Internet environment 
beyond the firewall are not supported.

Internet

PC with
Device Setup installed

PC with 
Device Setup installed

Intranet environment

PC with
Device Setup installed

Router

Internet environment: Not supported

Direct-connect environment: Not supported

Firewall

PC with
Device Setup 
installed
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Preparation for Connecting to Devices
This section explains the required preparation for connecting Device Setup to devices.

Checking Device Information
Before using Device Setup, you need to contact your system administrator to obtain device information. 
Obtain the following information: 
 Device models 
 Software version 
 System administrator ID 
 System administrator password

Note
You can check the software version at the device control panel. Press the [Machine Status] button on the 
control panel, and on the [Machine Status] screen, select [Machine Information] and check [Software 
Version]. Or, you can also check it by printing out the System Settings List of the device.

See
The manual of the device for details on the machine information.

Checking Machine Settings
Before using Device Setup, you need to check the device settings. Check the following information:

Essential Settings for Communicating with Devices
In order for Device Setup to connect to your devices, they must be in the following status. If not, make 
these settings at your devices. 
 Fixed IP address is set up

When your devices are configured to obtain IP address dynamically via DHCP or by other means: the 
devices and DNS server are set to obtain the current IP address from DNS host name.

 SNMP port is enabled by the UDP transport protocol 
 SOAP port is enabled

Note
You can check the status of the IP address and the port on the Printer Settings List or System Settings List of 
the device.

See
For information on how to initialize the IP address, refer to the manual of your device.

Essential Settings for E-mail / Internet Fax / File Transferring
To run e-mail, internet fax, or file transferring on your device, the following settings are required. These 
settings can also be configured with Device Setup. To do this, you must first check that Device Setup can 
communicate with devices and register the devices with Device Setup.
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E-mail / Internet Fax
Using Device Setup, you can create job flow sheets that include e-mailing and internet fax transmitting 
from the device. The device must be in the following status in order for it to use these job flow sheets. 
 [Device E-Mail Address] is set up 
 [Send E-mail] port is enabled 
 Outgoing e-mail protocol (SMTP) is set up

See
･ For some models, [Send E-mail] port and E-mail Protocol cannot be set using Device Setup. For information

on how to check and configure settings using Device Setup, refer to "Setting E-Mail Address of a Device"
(P.41), "Enabling Ports on a Device" (P.42), and "About E-mail Protocol Settings" (P.43).
･ For information on how to check and configure settings using the device control panel, refer to the manual

of the device.

File Transfer
You can use Device Setup to create job flow sheets that save scanned or faxed documents either to the 
shared folder in the PC using SMB transmission or to the FTP server using FTP transmission. The device 
must be in the following status in order for it to use these job flow sheets.

When using SMB transmission
 [SMB] port is enabled

When using FTP transmission 
 [FTP Client] port is enabled

See
･ For information on how to check and configure settings using Device Setup, refer to "Enabling Ports on a

Device" (P.42).
･ For information on how to check and configure settings using the device control panel, refer to the manual

of the device.

Using SSL in SOAP Communication with Devices
By using SSL in SOAP communication between Device Setup and devices, data transmitted between 
them can be encrypted. To use SSL, it is necessary that a certificate is set on the device, and that this 
device certificate is trusted by the PC where Device Setup is installed.
To check whether the device certificate is trusted, follow the procedure below. Before proceeding, 
contact your system administrator to check that preparations for using SSL have been completed at the 
device.

1.Start Internet Explorer on the PC where you will install Device Setup, and specify the following URL:
https://(DNS host name or IP address of device)

Note
Make sure to use Internet Explorer so that the device certificate is trusted in the Windows certificate store.

When the [Administrator Login] page appears, and an icon (padlock icon) indicating that connection
is protected by SSL is displayed on the status bar of Internet Explorer
1. The device certificate is trusted. Close Internet Explorer.

Note
When an error page such as “The page cannot be displayed” appears, check with the system administrator 
if preparations for using SSL have been completed, such as obtaining device certificate and settings to enable 
SSL.
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When the [Security Warning] dialog box is displayed with the message, “The security certificate from
this site is not valid”
1. The device certificate is not trusted. Click [View certificate], and then click [Install certificate] in

the displayed [Certificate] dialog box. In [Certificate Import Wizard] that appears, follow the
instructions on the screen to install the device certificate.
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3Installing Device Setup

Installing Device Setup for the First Time
This section explains the procedure to install Device Setup for the first time.

Note
･ Before proceeding installation of Device Setup, exit all applications. Once the installation has begun, do not

use other applications until the installation is canceled or completed.
･ You have to login to the PC where you will install Device Setup as a user of the Administrators group.

1.Double-click the "Launcher.exe" file.
 If the PC doesn't have Microsoft Visual C++ 2019 Redistributable Package (x86) installed on it, the 

installation screen is displayed.
Click [Install] on the installation screen.

Note
A message may prompt you to reboot your computer. If it appears, you have to reboot before using Device 
Setup. 

The [Welcome to the InstallShield Wizard for FUJIFILM Device Setup] dialog box appears. 

2.Click [Next].
The [License Agreement] dialog box appears. 

3.Check the content of the [License Agreement] dialog box, and then select [I accept the terms in the 
license agreement].

Note
Please read the license agreement carefully. Proceed only if you have no objection to the license agreement. 

4.Click [Next].
The [Add User Details] dialog box appears. 
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5.Fill in [User Name] and [Organisation], 
and then click [Next].

The [Destination Folder] dialog box appears. 

6.Check the installation folder for Device Setup, and then click [Next].

The [Ready to Install the Program] dialog box appears.

Note
･ To change the drive or folder for installation, click [Change], and enter the installation location. Up to 100

characters can be specified for the installation location.
･ A local fixed disk with at least 100 MB free space can be specified as the installation location. To check the

available space of the drive of your installation location, select [Drive]. 
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7.Check the components and location for installation, and then click [Install]. 

Installation begins. The [Setup Completed] dialog box appears when the installation is completed.

Note
A message may prompt you to reboot your computer. If it appears, you have to reboot before using Device 
Setup. 

8.Click [Finish].

The dialog box closes.
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Re-installing Device Setup
This section explains the procedure to re-install Device Setup.
You can re-install Device Setup without changing the previous settings. Carry this out, for example, when 
the related files of Device Setup are corrupted and Device Setup is not functioning properly.

Note
･ Before proceeding reinstallation of Device Setup, exit all applications. Once the reinstallation has begun, do

not use other applications until the reinstallation is canceled or completed.
･ You have to login to the PC where you will reinstall Device Setup as a user of the Administrators group.

1.Double-click the "Launcher.exe" file.
The [Welcome to the InstallShield Wizard for FUJIFILM Device Setup] dialog box appears. 

2.Click [Next].
The [Program Maintenance] dialog box appears. 

3.Check that [Repair] is selected, and then click [Next].

The reinstallation of the program begins. The maintenance completed dialog box appears when the 
installation is completed.

Note
A message may prompt you to reboot your computer. If it appears, you have to reboot before using Device 
Setup. 

4.Click [Finish].
The dialog box closes.
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Uninstalling Device Setup 
This section explains the procedure to uninstall (delete) Device Setup.
If you are going to reuse the current settings of Device Setup, you have to export the Device Setup device 
settings to a file before uninstalling.

Note
･ Before proceeding uninstallation of Device Setup, exit all applications. Once the uninstallation has begun,

do not use other applications until the uninstallation is canceled or completed.
･ You have to login to the PC where you will uninstall Device Setup as a user of the Administrators group.

See
For information on how to export the Device Setup device settings to a file, refer to "Exporting Device Settings 
to a File" (P.104).

1.From the Windows [Start] menu, select [Windows System] > [Control Panel].
The [Control Panel] window appears. 

2.Click [Uninstall a program] in [Program].
The [Programs and Features] window is displayed.

3.In the list of installed applications, select "FUJIFILM Device Setup {version}".

4.Click [Uninstall].
The [Programs and Features] dialog box appears.

5.Click [Yes].
The uninstallation of the program begins.
The message indicating the uninstallation progress is closed.
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4Starting Device Setup

Starting Device Setup
This section explains the following items:
 How to start Device Setup 
 How to refer to the electronic manual

Starting Device Setup
To start Device Setup, follow the procedure below.

1.From the Windows [Start] menu, select [FUJIFILM] > [Device Setup].
The [Enter Password for Device Setup] dialog box appears. 

2.Enter the password and click [OK].
The [Device Setup] window appear.

Note
The default password is "x-admin". Make sure to change the Device Setup password in order to improve 
security. You can do this in the [Change Device Setup Password] dialog box that is displayed when you select 
[Change Device Setup Password] from the [Edit] menu.

When you start Device Setup for the first time after upgrading 
 After upgrading Device Setup, a message on the newly added attributes may appear. These attributes 

have been assigned default values. When you have started Device Setup for the first time after 
upgrading, make sure to run [Get Attributes from Device].

See
For instructions, refer to "Getting Attribute Values from the Device" (P.39). 

 As it is necessary to specify the Controller ROM version (software version) for the previously 
registered devices, the [Device Type Specification] dialog box may appear.
When this happens, check the Controller ROM version of the device to specify it.

See
Checking Machine Information (p. 18) For information on how to check the Controller ROM version, refer
to "Checking Device Information" (P.20).

How to refer to the electronic manual
On a PC on which the Device Setup Tool is installed, select Windows [Start] menu, [Programs], 
[FUJIFILM], [Device Setup Tool], then [User's Guide]. A shortcut to the URL of the User's Guide will 
appear.
If your PC does not have the Device Setup Tool installed, place the Device Setup Tool DVD-ROM in the 
drive and double-click "DeviceSetup User Guide" in the "manual" folder.
If you downloaded the update module from the website, you will find the "manual" folder in the 
unzipped folder.
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Device Setup Components
This section explains window components of Device Setup.
The main Device Setup window consists of two frames. The left side is called Tree view, and the right, 
List view.

Tree View
Device Setup services, the devices managed by the services, and their attributes are displayed in a tree 
format. Right-clicking each of these items displays the context menu. The content of the context menu 
differs according to the service. The content of the tree view is as follows:

Services
A service is a plug-in module that has device managing features provided by Device Setup. Services are 
categorized into the types of features. 

See
For an overview of each service, refer to "Device Setup Features" (P.11). 

Devices 
Clicking [+] for a service displays the devices registered with the service.  As no device is registered with 
any of the services immediately after installing Device Setup, you have to register devices first. 
In tree view, only a single device can be selected. 

See
For information on how to register devices with services, refer to "Registering Devices with Device Setup" 
(P.32).

Attribute Values
Clicking [+] for a device displays the attribute values of the device.
An attribute value is a piece of information that the device has. Specially, attribute values correspond to 
the device's settings (e.g. enabled port or information about administrator) and registered data (e.g. 
user, mailbox, address book, or job flow sheet).
In tree view, only a single device can be selected.

Services

Devices

Attributes

Services
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List View
In Device Setup, the list view shows devices managed by the service, device status, attribute types and 
their values, in a list format.
In list view, multiple devices or attributes can be selected. This is useful when you want to configure the 
same settings for multiple devices all at once.
To select multiple devices or attributes, click the devices or attributes while pressing the <Shift> or < 
Ctrl> key on the keyboard.
To select all devices or attributes, select [Select All] from the [Edit] menu.
The following figures show examples of tree view.

When a Service is Selected in Tree View
The devices managed by the service, and their statuses are displayed in a list format.

When a Device is Selected in Tree View
The attributes of the device and their statuses are displayed in a list format.

Model 
name

Device status Attribute value of 
the device

Attribute 
types

Attribute 
status

Attribut
e values
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5Registering Devices with Device 
Setup

Flow of Operations (To Complete Registration of
Devices)

This section explains the flow of operations for registering devices with Device Setup.
Before you can use Device Setup, you need to register devices with Device Setup. The flow of operations 
differs depending on whether the device has already been installed or not.

When the Device Has Been Installed
Follow the operations below when the device has already been installed.
To register a device with Device Setup, IP address and suitable port must have already been set up on 
the device.

See
For information on the essential preparation on the device beforehand, refer to "Essential Settings for 
Communicating with Devices" (P.20).

When administrator name and password for the 
device have not been changed from factory 
preset setting

When administrator name and password for the device 
have been changed from factory preset setting

From here, configure settings for mailbox, address book/Contact Information, access permissions, job flow 
sheet and others, as needed.

Search for the device and register it with Device Setup（P.32）

Get attribute values from the device（P.39）

Edit basic information and reflect it in the device（P.102）

Configure settings to communicate with the device（P.38）
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When the Device Has Not Been Installed
Follow the operations below when the device has not been installed (e.g. before delivery).
It is possible to register a dummy (imaginary) device with Device Setup and edit the device data based 
on the scheduled plan, even if the device does not actually exist in your environment. After the device 
has been installed, the content edited with Device Setup can be reflected in the device.

Registering Devices with Device Setup
This section explains the following items: 
 How to register devices 
 How to set communication with devices 
 How to get attribute values from devices

Registering Devices
To register devices with Device Setup, follow the procedure below. 
 Search the network for devices and register them 
 Specify devices to register / register dummy (imaginary) devices

Note
If you did not set IP address when you
registered the dummy device, in Device Setup,
select [Device Identify Info] from the [Edit]
menu to set the same IP address as that set on
the device.

From here, configure settings for mailbox, address book/contact information, access permissions, job flow 
sheet and others, as needed.

Register a dummy device with Device Setup（P.36）

Install the device, and on the device, set IP address and suitable port（P.20）

Edit Basic Information and other services settings（P.40）

Edit basic information and other settings, and reflect them in the device（P.102）
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Searching the network for devices and registering them
To search the network for devices and register them with Device Setup, follow the procedure below.

Note
Search and Add Device operation can be performed for devices that meet the following conditions:
･ Fixed IPv4 address is set up. If the device is configured to obtain IP address dynamically via DHCP or by 

other means, register it by specifying its DNS host name. If the device has fixed IPv6 address but does not 
have fixed IPv4 address, register it by specifying the fixed IPv6 address or its DNS host name.
･ The SNMP v1/v2 community name or the SNMP v3 password has not been changed from the factory 

default. If the community name or the password has been changed from the factory default, register the 
device by specifying the fixed IP address or its DNS host name.
･ Device Setup can connect to devices via TCP/IP.
･ It is recommended to register up to 10 devices with Device Setup.at a maximum. There is no limit to the 

number that can be registered. However, depending on your environment, registering too many devices 
may cause unstable computer operations due to insufficient memory.

1.Expand tree view, and select a service. 

2.Select [Search and Add Device] from the [Edit] menu.
The [Search and Add Device] dialog box appears. 

Note
To search for devices in the same subnet as the computer where Device Setup is installed, proceed to Step 6.

3.To search for devices in other subnet, click [Search Condition].

The [Search Condition] dialog box appears. 
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4.Enter the subnet broadcast address of the device in [Add a subnet address], and then click [Add].

The address is added to [Search the following subnet addresses].

Note
If you do not know the network broadcast address of the device, check with the network administrator for 
your environment.

5.Click [OK] when you have configured all the search conditions.

This returns you to the [Search and Add Device] dialog box. 

6.Click [Search].

Searching for devices begins. After the searching has ended, the devices found are displayed in the [Add 
Device] dialog box. 
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7.Confirm the device to be registered, and click [OK].

The [Add Device - Get Device Attributes] dialog box appears. 

8.Confirm the content, and Click [Yes].
Retrieving of device attribute values begins. When the device attribute values have been retrieved, the 
message, "The following device(s) is added" will be displayed. 

9.Click [OK].
The device is registered under the service.

Note
When the message, "Failed to retrieve the latest attributes from the device." appears, check the power and 
network settings of the device. When the User ID or password of the system administrator has been changed 
from its factory preset setting, the device attributes cannot be retrieved. You need to configure a way to 
communicate with the device, and then retrieve the device attribute values again. Refer to "Configuring 
Settings to Communicate with the Device" (P.38) . and "Getting Attribute Values from the Device" (P.39).



36

Specifying Devices to Register / Registering Dummy (Imaginary) Devices
Any of the devices that are already connected to the network can be specified and registered with 
Device Setup. Also, a dummy (imaginary) device can be registered with Device Setup, even if it does not 
actually exist in your environment. By registering a dummy device with Device Setup, configuration of 
service settings at Device Setup can be completed in advance when preparing for the delivery of device.

1.Expand tree view, and select a service. 

2.Select [Add Device] from the [Edit] menu.
The [Add Device] dialog box appears.

3.Set the model name and IP address as the identity information of the device.
If you select a device model for which multiple versions exist in the Controller ROM, the item, 
[Software Version] is enabled. When this happens, select the Controller ROM version of the device 
from [Software Version].
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When registering a device which is connected to the network
Specify the actual model name, and either the IP address or host name. IPv4 address or IPv6 address 
can be specified for the IP address. Selecting the [Get the latest attributes from the specified device(s)] 
check box and then clicking [OK] will populate Device Setup with the current settings of the device.

When registering a dummy device
Specify the model name of the device that is planned to be installed, and the IP address or host name 
to be allocated to the device.

Note
･ Leave the [Get the latest attributes from the specified device(s)] checkbox unselected. Selecting the check 

box and clicking [OK] will lead to attempts to communicate with a device that does not actually exist, and 
result in an error.
･When registering a device that is configured to obtain IP address dynamically via DHCP or by other means, 

specify the DNS host name or computer name in [Host Name].
･ You can change the model name, software version, IP address and DNS host name even after you have 

registered the device. To change these items, use the [Device Identity Info] dialog box that is displayed 
when you select [Device Identity Info] from the [Edit] menu. 
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4.Click [OK].
The device is registered under the service.

Note
For devices that are already connected to the network, when the message, “Failed to retrieve the latest 
attributes from the device.” appears, check the power and network settings of the device. When the User ID 
or password of the system administrator has been changed from its factory preset setting, the device 
attributes cannot be retrieved. You need to configure a way to communicate with the device, and then 
retrieve the device attribute values again. Refer to "Configuring Settings to Communicate with the Device" 
(P.38) . and "Getting Attribute Values from the Device" (P.39).

Configuring Settings to Communicate with the Device
Device Setup uses the User ID and password of the system administrator to communicate with devices. 
By default, Device Setup is assigned the same User ID and password of the system administrator as the 
ones that was set on the device at shipment. If you change the User ID and password of the system 
administrator at the device, change those values registered with Device Setup as well. Also, if the SNMP 
settings have been changed from the factory defaults at the device, change the settings registered with 
Device Setup as well.
To configure settings to communicate with the device, follow the procedure below.

1.In tree view, select the device below the service. 

2.Select [Device Communication Settings] from the [Edit] menu.
The [Device Communication Settings] dialog box appears.
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3.Enter the User ID and password of the system administrator set on the device in [System 
Administrator ID], [Passcode/Password] and [Confirm Passcode/ Password].
Also, enter the settings in [SNMP] and [Port Number] as well. 

4.Click [OK].

Getting Attribute Values from the Device
Once you have set values such as the User ID and password of the system administrator and SNMP on 
Device Setup to enable communication with devices, you can retrieve the latest attribute values from a 
device to Device Setup.
An attribute value is a piece of information that the device has. Specially, attribute values correspond to 
the device's settings (e.g. enabled port or information about administrator) and registered data (e.g. 
user, mailbox, address book, or job flow sheet).
To retrieve attribute values from a device, follow the procedure below.

See
For information on if you cannot retrieve attributes from devices with Device Setup, refer to"Cannot Retrieve 
/ Set Attributes From Device" (P.158)

1.In tree view, select the device below the service.
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2.From the [Edit] menu, select [Get Attributes from Device].
A dialog box appears to confirm retrieving attribute values. 

3.To retrieve attribute values from the selected service only, click [OK].
To retrieve attribute values from unselected services as well, select the [Get all the attributes from the 
device except for (service name)] check box.

Retrieving of attribute values begins. 

4.Click [OK] when the retrieving of attribute values is complete.
The newest attribute values are retrieved from the device to Device Setup, and the device status is 
change from "New" to "Saved/Retrieved".

Setting Basic Information
This section explains the following items: 
 About Basic Information Service 
 How to set information on devices

About Basic Information Service
Basic Information service is a service for reflecting the following settings from Device Setup in devices.
The attributes that can be set with the Basic Information service are as follows: 
 Product information of the device 
 Port to be enabled 
 Time before the device enters power save mode 
 Protocol basic settings 
 Device internal clock 
 System administrator account
 Encryption key for confidential data
Many of the attributes you set with Basic Information service are typically common to many devices, so 
you can set those attributes all at once by selecting multiple devices. This helps you to set multiple 
devices efficiently.

Setting Information on Devices
This section explains, as an example, how to set the following settings in Device Setup: e-mail address, 
port to be enabled, and protocols to be applied to the device. To set these settings, follow the procedure 
below.
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Setting E-Mail Address of a Device
To run e-mail or internet fax on your device, you need to set the device e-mail address at the device.

1.In tree view, expand [Settings] ＞ [General Device Settings] ＞ [Basic Information], and then select
the device to be configured.

2.Select [Product Info] from the [Service] menu.
The [Product Info] dialog box appears. 

3.Specify [Device E-mail Address]. Change other settings as needed. 

4.Click [OK].

The settings are reflected in Device Setup.

Note
At this point, the device e-mail address has not been set on the device. Set it on the device, as needed. For 
instructions, refer to "Reflecting Your Settings in Devices" (P.102).
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Enabling Ports on a Device
You can enable or disable ports on a device from Device Setup.

See
For information on ports that need to be enabled on a device so that you can use Device Setup to set up the 
device for users to run e-mail, internet fax, or file transferring on the device, refer to "Essential Settings for E-
mail / Internet Fax / File Transferring" (P.20).

1.In tree view, expand [Settings] ＞ [General Device Settings] ＞ [Basic Information], and then select
the device to be configured.

Note
To select all the devices registered with the Basic Information service, expand [Basic Information] in tree view, 
and then from the [Edit] menu, select [Select All]. You can also select multiple devices from list view by 
clicking those devices while holding the <Shift> key or <Ctrl>key. You can do the same for the other services 
as well. 

2.Select [Enable Port Settings] from the [Service] menu.
The [Enable Port Settings] dialog box appears. 

3.Select the check box for the ports to be enabled.

See
･ For information on device models whose [Send E-mail] port can be set, refer to Readme.txt.
･ For more information on each of the ports, refer to the Help. 

4.Click [OK].



5 　Registering Devices with Device Setup

43

The settings are reflected in Device Setup.

Note
At this point, the ports have not been set on the device. Set them on the device, as needed. For instructions, 
refer to "Reflecting Your Settings in Devices" (P.102).

Setting Protocols on a Device
To use e-mail and internet fax at the device, you need to set the protocol for sending e-mail (SMTP) on 
the device.
Using Device Setup, you can set the e-mail protocols (SMTP and POP) and TCP/IP (network interface 
settings) on the device.

Note
For some models, [E-mail Protocol Settings] cannot be set using Device Setup. For information on the 
models, refer to Readme.txt.

About E-mail Protocol Settings
To set e-mail protocol, follow the procedure below.

1.In tree view, expand [Settings] ＞ [General Device Settings] ＞ [Basic Information], and then select
the device to be configured. 

2.Select [E-mail Protocol Settings] from the [Service] menu.
The [E-mail Protocol Settings] dialog box appears. 

3.Set each of the items.
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Note
If the SMTP server name or POP3 server name is the DNS host name, connection may fail. In this case, set 
the IP address.

See
･ For more information on each of the items, refer to the Help.
･ For information on how to edit the password, refer to "Editing Passwords" (P.154).

4.Click [OK].

The settings are reflected in Device Setup.

Note
At this point, e-mail protocol settings have not been set on the device. Set them on the device, as needed. 
For instructions, refer to "Reflecting Your Settings in Devices" (P.102).
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About TCP/IP Settings
Using the TCP/IP settings, you can configure or change settings such as the IP address of the device or 
DNS server address referred by the device.
To check and change the settings, follow the procedure below.

1.In tree view, expand [Settings] ＞ [General Device Settings] ＞ [Basic Information], and then select
the device to be configured. 

2.Select [Protocol Settings (TCP/IP)] from the [Service] menu.
The [Protocol Settings (TCP/IP)] dialog box appears.

3.Check the settings of each item. Change the settings as needed. 

4.Click [OK].

The settings are reflected in Device Setup.
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Note
At this point, TCP/IP protocol settings have not been set on the device. Set them on the device, as needed. 
For instructions, refer to "Reflecting Your Settings in Devices" (P.102).

Setting Mailboxes
This section explains the following items: 
 About Mailbox Service 
 How to set mailboxes 
 How to create multiple mailboxes all at once 
 How to use mailboxes

About Mailbox Service
Mailbox is an area for storing data that are to be input/sent to the device, and for retrieving as needed.

The Device Setup's Mailbox service allows you to carry out the following mailbox related operations for 
the device: Available operations are as follows: 
 Create mailbox 
 Change mailbox settings 
 Copy mailbox 
 Delete mailbox 
 Create multiple mailboxes all at once

Adding Mailboxes to a Device
You can add mailboxes on Device Setup by either of the following ways: 
 Create a new mailbox 
 Copy mailboxes

Creating a New Mailbox
To add a new mailbox, follow the procedure below.

1.In tree view, expand [Settings] ＞ [Scanner/Fax-Specific Settings] ＞ [Mailbox], and then select the
device. 

Scanned document

Fax

Internet fax

IP fax (SIP)

E-mail
Mailbox
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2.Select [Create Mailbox] from the [Service] menu.
The [Create Mailbox] dialog box appears. 

3.Set each of the items.
Click [Edit Password] before you can enter the password.

See
･ To not associate the mailbox with a job flow sheet, select [None] from [Linked Job Flow Sheet]. For 

information on how to associate the mailbox with a job flow sheet, refer to "Creating Job Flow Sheet 
Starting from Mailbox" (P.135).
･ For information on how to edit the password, refer to "Editing Passwords" (P.154). 

4.Click [OK].

A new mailbox is created.

5.By repeating the steps above, you can create as many mailboxs as you want.

Note
At this point, the mailboxes have not been set on the device. Set them on the device, as needed. For 
instructions, refer to "Reflecting Your Settings in Devices" (P.102).
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Copying Mailboxes
You can copy the mailboxes created using the procedure above to another device. To copy mailboxes, 
follow the procedure below.

1.In tree view, expand [Settings]＞ [Scanner/Fax-Specific Settings] > [Mailbox], followed by the device
from which to copy mailboxes, and then select [Mailbox List].

Note
To copy mailboxes individually, select the mailboxes in tree view or list view. 

2.Select [Copy Mailbox] from the [Service] menu. 

3. In tree view, expand the device to which to copy, and then select [Mailbox List].

4.Select [Paste Mailbox]from the [Service] menu.

The mailboxes are pasted into the mailbox list.
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Note
･ At this point, the mailboxes have not been set on the device. Set them on the device, as needed. For 

instructions, refer to "Reflecting Your Settings in Devices" (P.102).
･ If there is a mailbox of the same number on the target device, the [Mailbox - Confirm Paste] dialog box 

appears.
Selecting [Overwrite Existing Mailbox No.] will overwrite the settings of the mailbox with the same number 
registered with Device Setup. (At this point, the settings have not been reflected in the device.) To register 
the settings as another number, select [Register As Another Mailbox No.], and enter a new number.

Creating Multiple Mailboxes All at Once
You can create multiple job flow sheets all at once by using “Device Setup IuputTool” and Device Setup. 
This is useful when you want to register multiple mailboxes with a single device.
Device Setup InputTool is a file in the Microsoft Excel workbook format.
Multiple mailboxes can be created all at once by entering information on each of the mailboxes in the 
provided Excel sheet, export the data, and then import it into Device Setup.

Note
Device Setup InputTool allows you to create many settings all at once by using Microsoft Excel. When saving 
Device Setup InputTool containing those settings, make sure to save it in a safe way to avoid personal 
information from being compromised. For example:
･ Saving as a Zip file protected with a password
･ Saving in a folder where access permissions are set

Creating Batch Input File Using Device Setup InputTool
You can create a file for creating multiple mailboxes all at once using Device Setup InputTool. To do this, 
follow the procedure below.

Important
Device Setup exports the file in a format unique to itself. Do not edit the file using other applications.

Note
･ Information on the mailboxes you change at the device or on Device Setup are not reflected in Device Setup 

InputTool. Therefore, the content in the Excel sheet may be different from the latest settings of the device.
･ The extension of the exported batch input file is “mb3” (a format unique to Device Setup).

1.From the Windows [Start] menu, select [FUJIFILM] >[Device Setup InputTool].
The [InputTool] window appears. 

2.Double click the “Device Setup InputTool - Mailbox.xls” file.
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Note
･ Device Setup InputTool uses macros. To use this tool, you need to specify [Medium] or less for the security 

level of Microsoft Excel. When [Medium] is specified, a message confirming the execution of a macro is 
displayed. Click [Enable Macros].
･ Double clicking “Usage of Device Setup InputTool.txt” displays the additional information and restrictions 

for Device Setup InputTool. 

See
For information on the Excel versions supported by Device Setup InputTool, refer to "Required System 
Environment" (P.19).

3.In the displayed Excel sheet, enter information on each of the mailboxes to create. Enter information 
elements for mailboxes, one mailbox per row. Up to 500 mailbox data can be entered.
After completing entering the data, click [▼ ] for the cell in the [Data Processing] column on the last 
row you entered, and then select [End of Data].

Note
You can check if the values entered in the cells are correct by clicking [Check Data]. This check is the same as 
the one performed when you click [Export Data] in Step 4.

See
 For information on what information you need to enter in each of the cells, refer to the Help displayed when 

you click the header cell.
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4.Click [Export Data].
The values in the cells are verified. If a value is incorrect, the error cell is highlighted, and the error 
message appears. 
Enter the correct value, and then click [Export Data] again.
If there is no error, the [Save As] dialog box appears. 

5.Specify the filename and storage location, and then click [Save].

The [Data Export] message appears. 

6.Click [OK].
The batch input file with “mb3” extension (a format unique to Device Setup) is created in the specified 
location. 
The original workbook provided for the product cannot be overwritten. To save the data you entered, 
select [Save As] from the [File] menu, and specify a file name.

Note
Save the file in a folder where access permissions are set, which is located in a different place than the Device 
Setup installation folder.

7.Select [Close] from the [File] menu.
Device Setup InputTool is exited.

Importing the Batch Input File Using Device Setup
To import the batch input file exported from Device Setup InputTool into Device Setup, follow the 
procedure below.

1.In tree view, expand [Settings] ＞ [Scanner/Fax-Specific Settings] ＞ [Mailbox], and then select the
device. 

2.Select [Import Mailbox] from the [Service] menu.
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The [Open] dialog box appears. 

3.Browse to the location into which the batch input file was exported in the previous section.
Select the batch input file (extension "mb3”), and click [Open].

The [Mailbox information contents confirmation] dialog box appears. 

4.Check if there is no wrong information on the mailbox to create.
After checking the information, click [Yes].

The [Mailbox - Confirm Overwrite] dialog box appears.

5.Select whether to overwrite the mailbox.
After selecting the option, click [OK].

A confirmation message appears. 
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6.Click [OK].

The mailboxes imported from the batch input file are displayed in [Mailbox List].

Note
At this point, the mailboxes have not been set on the device. Set them on the device, as needed. For 
instructions, refer to "Reflecting Your Settings in Devices" (P.102).
If your device does not have relevant features, an error will occur at the time you attempt to set them for the 
device.

Using Mailboxes
To use the created mailboxes, follow the procedure below.

Note
Before proceeding, make sure to set the mailboxes on the device. For more information, refer to "Reflecting 
Your Settings in Devices" (P.102).

1.Load the document on the device. 

2.Press the [All Services] button on the control panel of the device, and select [Scan to Mailbox]. 

3.Select the mailbox for storing data, and carry out the scanning. 

4.On your PC, import the scanned data from the mailbox.

See
The procedure may differ depending on the device in use. For more instructions, refer to the manual of the 
device.

Setting Address Book
This section explains the following items: 
 About Address Book service
 How to set Address Book on a device
 How to export Address Book to a file, and how to import it into Device Setup
 How to create multiple recipients all at once
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About Address Book Service
Address Book service is a service for managing the address book of the device using Device Setup.
The Address Book includes information such as fax address numbers (speed dial numbers) and 
recipients.
Loading a document on the device and selecting an address number (speed dial number) will send the 
document to the recipient.
Types of recipient include not only fax but also e-mail, internet fax, and server (SMB or FTP).
On a device that supports e-mail transmission or scan-to-server, loading a document and selecting an 
address number (speed dial number) will scan the document, and then send the scanned image by e-
mail or send it to a shared folder or FTP server.

Setting Address Book on a Device
To add address book on Device Setup, follow the procedure below. 
 Create a new Address Book 
 Copy a Address Book

Creating a New Address Book

1.In tree view, expand [Settings]＞ [Scanner/Fax-Specific Settings] > [Address Book], and then select
the device. 

2.Select [Create Recipient] from the [Service] menu.
The [Create Recipient] dialog box appears. 

Address No. 1

Address No. 2

Address No. 3

Fax

E-mail

Server
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3.Set each of the items. 

4.Click [OK].

A new recipient is created. 

5.By repeating the steps above, you can create as many recipients.as you want.

Note
At this point, the address book has not been set on the device. Set it on the device, as needed. For 
instructions, refer to "Reflecting Your Settings in Devices" (P.102).
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Copying a Address Book
You can copy the address book registered with Device Setup to another device.

Note
When you copy Address Book between the devices whose maximum allowed registration number of 
recipients is different, the number of recipients is limited to the maximum allowed number that the target 
device supports.

1.In tree view, expand [Settings]＞ [Scanner/Fax-Specific Settings] > [Address Book], followed by the
device that includes the recipients to be copied＞ and then select [Address Book].
To copy recipients individually, select the recipients in tree view or list view. 

2.Select [Copy Recipient] from the [Service] menu. 

3. In tree view, expand the device to which to copy recipients, and then select [Address Book].
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4.Select [Paste Recipient] from the [Service] menu.

The address book is pasted into the address book.

Note
At this point, the address book has not been set on the device. Set it on the device, as needed. For 
instructions, refer to "Reflecting Your Settings in Devices" (P.102).

Exporting and Importing Address Book
You can export address book for a device registered with Device Setup to a file. You can also import the 
exported file to Device Setup.
This function is useful when you want to use the same address book in Device Setup on another PC.

Important
Device Setup exports the file in a format unique to itself. Do not edit the file using other applications.

Note
The extension of the exported address book file is “mb5” (a format unique to Device Setup).

Exporting Address Book to a File

1. In tree view, expand [Settings]＞ [Scanner/Fax-Specific Settings] > [Address Book], and then select
the device.
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2.Select [Export Address Book] from the [Service] menu.
The [Address Book - Export Check] dialog box appears. 

3.Check the contents of the [Address Book - Export Check] dialog box, and click [Yes].

The [Save As] dialog box appears. 

4.Specify the filename and storage location, and then click [Save].

An address book file with extension “mb5” (a format unique to Device Setup) is created in the specified 
location.

Importing the Address Book File into Device Setup
To import the address book file you exported in the previous section into Device Setup, follow the 
procedure below.

1.In tree view, expand [Settings]＞ [Scanner/Fax-Specific Settings] > [Address Book], and then select
the device. 

2.Select [Import Address Book] from the [Service] menu.
The [Address Book - Import Check] dialog box appears. 
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3.Check the contents of the [Address Book - Import Check] dialog box, and click [Yes].

The [Open] dialog box appears. 

4.Browse to the location into which the address book file was exported in the previous section.
Select the address book file (“mb5” extension), and then click [Open].

The [Address information contents confirmation] dialog box appears. 

5.Check if there is no wrong information on the address book to import to Device Setup.
After checking the information, click [OK].

The [Address Book- Confirm Overwrite] dialog box appears.
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6.Select whether to overwrite the address book or not, and click [OK].

A confirmation message appears. 

7.Click [OK].

The recipients imported from the file are displayed in [Address Book].

Note
At this point, the address book has not been set on the device. Set it on the device, as needed. For 
instructions, refer to "Reflecting Your Settings in Devices" (P.102).
If your device does not have relevant features, an error will occur at the time you attempt to set them for the 
device.

Using Address Book

Note
Before proceeding, make sure to set the address book on the device. For more information, refer to 
"Reflecting Your Settings in Devices" (P.102).

1.Load the document on the device. 

2.Press the [All Services] button on the control panel of the device, and select [Fax / Internet Fax]. 

3.Press the [Speed Dial] button, and then enter the speed dial number using the numeric keypad. 

4.Press the [Start] button.

See
The procedure may differ depending on the device in use. For more instructions, refer to the manual of the 
device.
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Creating Multiple Recipients All at Once
Device Setup InputTool and Device Setup allow you to create multiple recipients all at once. This is 
useful, for example, when you want to register multiple recipients with a single device.
Device Setup InputTool is a file in the Microsoft Excel workbook format.
To enter multiple recipients in the provided Excel sheet, export data, and import the exported data into 
Device Setup to create recipients all at once, follow the procedure below.

Note
Device Setup InputTool allows you to create many settings all at once by using Microsoft Excel. When saving 
Device Setup InputTool containing those settings, make sure to save it in a safe way to avoid personal 
information from being compromised. For example:
･ Saving as a Zip file protected with a password
･ Saving in a folder where access permissions are set

Creating Batch Input File Using Device Setup InputTool
“Device Setup InputTool - Address Book.xls” is composed of the following Excel sheets: 
 Fax

Used when you create recipients whose address type is fax). Items that can be set are [Address No], 
[Recipient Name], [Index Character], [Recipient (Fax No)], [Extension/Outside Line], 
[Communication Mode] and [Resolution]. 

 Internet
Used when you create recipients whose address type is fax). Items that can be set are [Address No], 
[Recipient Name], [Recipient (E-mail Address)], [Communication Mode], [Resolution],[Maximum 
Image Size] and [Internet Fax Profile]. 

 E-mail
Used when you create recipients whose address type is E-mail. Items that can be set are [Address 
No], [Recipient Name],  [Recipient (E-mail Address)], [Last Name], [First Name], [Custom Item 1], 
[Custom Item 2] and [Custom Item 3]. 

 Server
Used when you create recipients whose address type is server. Items that can be set are [Address No], 
[Recipient Name], [Transfer Protocol], [Server Name/IP Address], [Shared Name], [Save In], [Login 
Name], [Password] and [Port No]. 

 IP fax (SIP)
Used when you create recipients whose address type is IP fax (SIP). Items that can be set are [Address 
No], [Recipient Name], [Index Character], [Recipient (Fax No)], [Communication Mode] and 
[Resolution]. 

 Address Number List
Used when the address type and recipient name described in the [Fax], [Internet Fax], [E-mail], 
[Server] and [IP Fax (SIP)] sheets are displayed in order of [Address No] (speed dial number / address 
number).

Important
Device Setup exports the file in a format unique to itself. Do not edit the file using other applications.

Note
･ Information on the recipients you change at the device or on Device Setup are not reflected in Device Setup 

InputTool. Therefore, the content in the Excel sheet may be different from the latest settings of the device.
･ The extension of the exported batch input file is “mb5” (a format unique to Device Setup).
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The following procedure explains how to perform a batch creation of recipients using the [Fax] and [E-
mail] sheets.

1.From the Windows [Start] menu, select [FUJIFILM] >[Device Setup InputTool].
The [InputTool] window appears. 

2.Double click the “Device Setup InputTool - Address Book.xls” file.

Note
･ Device Setup InputTool uses macros. To use this tool, you need to specify [Medium] or less for the security 

level of Microsoft Excel. When [Medium] is specified, a message confirming the execution of a macro is 
displayed. Click [Enable Macros].
･ Double clicking “Usage of Device Setup InputTool.txt” displays the additional information and restrictions 

for Device Setup InputTool. 

See
For information on the Excel versions supported by Device Setup InputTool, refer to "Required System 
Environment" (P.19).

3.Select the Excel sheet to use, and enter recipients information you want to create.
Enter the recipient information in both [Fax] and [E-mail] sheets as an example here.
Enter recipients information, one recipient per row. [[Address No] must meet the following conditions.
 The numbers are in the range from 1 to 2000.
 The numbers do not overlap across the [Fax], [Internet Fax], [E-mail], [Server]and [IP Fax (SIP)] 

sheets.

Note
･ Some items in the [Create Recipient] dialog box are not included in “Device Setup InputTool - Address Book. 

xls”. When you export the data, these items are assigned default values. If you want to change attribute 
values for the items that are not included in “Device Setup InputTool - Address Book. xls”, use Device Setup 
to edit them.
･ If you leave optional items blank in "Device Setup InputTool - Address Book. xls”, these items are also 

assigned default values when you export the data.
･ The maximum number of address books allowed varies depending on the device.

See
For information on what information you need to enter in each of the cells, refer to the Help displayed when 
you click the header cell.
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4. After completing entering the data, click [▼ ] for the cell in the [Data Processing] column on the last 
row you entered, and then select [End of Data].

 [Fax] sheet status

 [E-mail] sheet status

Note
･When you click [Check Data] or [Export Data] without setting the [End of Data] row, an error occurs.
･ To export recipients from the inactive sheet, the [End of Data] row must be set in the sheet.
･ Do not set [End of Data] in a blank sheet.
･ You can check if the values entered so far in the cells are correct by clicking [Check Data]. This check is the 

same as the one performed when you click [Export Data] in Step 6. 

5.Select the [Address Number List] sheet, and then click [Update List].
The address types and recipient names from the beginning to the end row with [End of Data] specified, 
in each of the [Fax], [Internet Fax], [E-mail], [Server] and [IP Fax (SIP)] sheets, are listed in the order of 
address numbers. The rows for which [Skip] is set are not displayed.

Note
If [Address No] is duplicated, or a number is out of range, an error message is displayed. In addition, a cursor 
is moved to the error cell. Modify the data, and click [Update List] again. 
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6.Click [Export Data].
If a value is incorrect, the error cell is highlighted, and the error message appears. If all data is correct, 
the [Data Export] dialog box appears. 

7.Check the sheets to be exported to the batch input file . After checking the information, click [Yes].

The [Save As] dialog box appears.

8.Specify the filename and storage location, and then click [Save].

The [Data Export] message appears. 

9.Click [OK].
The batch input file with “mb5” extension (a format unique to Device Setup) is created in the specified 
location. 
The original workbook provided for the product cannot be overwritten. To save the data you entered, 
select [Save As] from the [File] menu, and specify a file name.

Note
Save the file in a folder where access permissions are set, which is located in a different place than the Device 
Setup installation folder.

10.Select [Close] from the [File] menu.
Device Setup InputTool is exited.

Import Batch Input File Using Device Setup

See
Refer to "Importing the Address Book File into Device Setup" (P.58).
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Setting Fax Group
See
For an overview of fax group, refer to "Creating Fax Group" (P.15).

This section explains the following items:
 How to set fax group on a device
 How to export a fax group to a file, and how to import it into Device Setup
 How to create multiple fax groups all at once

Setting Fax Group on a Device
You can add fax group on Device Setup by either of the following ways: 
 Create a new Fax Group
 Copy a Fax Group

Creating a New Fax Group

1.In tree view, expand [Settings] > [Scanner/Fax-Specific Settings] > [+] at [Fax Group], and then select
the device. 

2.Select [Create Fax Group] from the [Service] menu. 
The [Create Fax Group] dialog box appears.

3.Set each of the items.
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4.Click [OK].

A new fax group is created.

Note
At this point, the fax group have not been set on the device. Perform the procedure in "Reflecting Your 
Settings in Devices" (P.102), as needed.

Copying a Fax Group
You can copy the fax groups registered with Device Setup to another device.

Note
When you copy fax group between the devices whose maximum allowed registration number of fax groups 
is different, the number of fax groups is limited to the maximum allowed number that the target device 
supports. 

1.In tree view, expand [Settings] > [Scanner/Fax-Specific Settings] > [+] at [Fax Group] > [+] at the
original device to be copied, and then select [Fax Group List].

Note
To copy fax group individually, select the recipients in tree view or list view. 

2.Select [Copy Fax Group] from the [Service] menu. 
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3.Select [+] at the device that is the copy destination, and then [Fax Group List] in the tree view. 

4.Select [Paste Fax Group] from the [Service] menu.

The fax group are pasted.

Note
At this point, the fax group have not been set on the device. Perform the procedure in "Reflecting Your 
Settings in Devices" (P.102), as needed.

Exporting and Importing Fax Group
You can export fax group for a device registered with Device Setup to a file. You can also import the 
exported file to Device Setup.
This function is useful when you want to use the same fax group in Device Setup on another PC.

Important
Device Setup exports the file in a format unique to itself. Do not edit the file using other applications.

Note
The extension of the exported fax group file is “mb6” (a format unique to Device Setup).
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Exporting Fax Group to a File

1. In tree view, expand [Settings] > [Scanner/Fax-Specific Settings] > [+] at [Fax Group], and then select
the device. 

2.Select [Export Fax Group ] from the [Service] menu.
The [Save As] dialog box appears. 

3.Specify the location and file name for saving the file, and then click [Save].
A fax group file whose extension is "mb6", unique format to Device Setup, is created in the specified 
location.

Importing the Fax Group File into Device Setup

1.In tree view, expand [Settings] > [Scanner/Fax-Specific Settings] > [Fax Group], and then select the
device.

2.Select [Import Fax Group ] from the [Service] menu.
The [Open] dialog box appears. 

3.Browse to the location into which the fax group file was exported in the previous section.
Select the file whose extension is "mb6", and then click [Open].
The [Fax Group information contents confirmation] dialog box appears. 
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4.Make sure there is no problem, and click [OK]. 

5.Select whether to overwrite the fax group or not, click [OK].

The fax group imported from the file are displayed in [Fax Group List].

Note
At this point, the fax group have not been set on the device. Perform the procedure in "Reflecting Your 
Settings in Devices" (P.102), as needed.
If your device does not have relevant features, an error will occur at the time you attempt to set them for the 
device.



70

Creating Multiple Fax Groups All at Once
Device Setup InputTool allows you to create multiple recipients all at once. This is useful, for example, 
when you want to register multiple fax groups with a single device.
Device Setup InputTool is a file in the Microsoft Excel workbook format.

Creating Batch Input File Using Device Setup InputTool

Important
Device Setup exports the file in a format unique to itself. Do not edit the file using other applications.

Note
･ Fax Group you change at the device or on Device Setup are not reflected in Device Setup InputTool. 

Therefore, the content in the Excel sheet may be different from the latest settings of the device.
･ The extension of batch input file is "mb6", the unique format to Device Setup.

1.From the Windows [Start] menu, select [FUJIFILM] > [Device Setup InputTool].
The [InputTool] window appears.

2.Double click the “Device Setup InputTool - Fax Group.xls” file.

Note
･ Device Setup InputTool uses macros. To use this tool, you need to specify [Medium] or less for the security 

level of Microsoft Excel. When [Medium] is specified, a message confirming the execution of a macro is 
displayed. Click [Enable Macros].
･ Double clicking “Usage of Device Setup InputTool.txt” displays the additional information and restrictions 

for Device Setup InputTool. 

See
For information on the Excel versions supported by Device Setup InputTool, refer to "Required System 
Environment" (P.19).

3.Enter the fax group information to create, one group per row.

Note
The maximum number of fax groups allowed varies depending on the device.

See
For information on what information you need to enter in each of the cells, refer to the Help displayed when 
you click the header cell.
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4. After completing entering the data, click [▼ ] for the cell in the [Data Processing] column on the last 
row you entered, and then select [End of Data].

Note
･When you click [Check Data] or [Export Data] without setting the [End of Data] row, an error occurs.
･ You can check if the values entered so far in the cells are correct by clicking [Check Data]. This check is the 

same as the one performed when you click [Export Data] in the next step. 

5.Click [Export Data].
If a value is incorrect, the error cell is highlighted, and the error message appears. If there is no error, the 
[Save As] dialog box appears. 

6.Specify the filename and storage location, and then click [Save]. 
The [Data Export] message appears.

7.Click [OK].
The batch input file with “mb6” extension (a format unique to Device Setup) is created in the specified 
location. 

8.Select [Close] from the [File] menu.
Device Setup InputTool is exited.

Importing the Batch Input File Using Device Setup

See

Refer to "Importing the Fax Group File into Device Setup" (P.68).

Setting up the Contact Information
This section explains the following items:
 About Contact Information Service
 How to set an contact information for a device
 How to export the contact information to a file, and how to import it into Device Setup
 How to create multiple contact information all at once
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About Contact Information Service
Contact Information service is a service for managing the contact information of the device using Device 
Setup.
An contact information is information on recipients that you have saved with their attributes. 
Load a document on the device, enter the recipient name and attributes, and then select the recipient 
address.
Types of recipient include not only fax but also e-mail, internet fax, and server (SMB or FTP).
On a device that supports e-mail transmission or scan-to-server, loading a document and selecting a 
recipient will scan the document, and then send the scanned image by e-mail or send it to a shared 
folder or FTP server.

Setting an Contact Information for a Device
You can add an contact information on Device Setup by either of the following ways: 
 Create a new contact information
 Copy an contact information

Creating a New Contact Information

1.In tree view, expand [Settings]＞ [Scanner/Fax-Specific Settings] > [Contact Information], and then
select the device. 

2.Select [Add Contact] from the [Service] menu.
The [Add Contact] dialog box appears. 

Recipient name/attribute

Recipient name/attribute

Recipient name/attribute

Fax

E-mail

Server
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3.Set each of the items. 

4.Click [OK].

A new contact information is created. 

5.By repeating the steps above, you can create as many contact information as you want.

Note
At this point, the contact information has not been set on the device. Set it on the device, as needed. For 
instructions, refer to "Reflecting Your Settings in Devices" (P.102).

Copying an Contact Information
You can copy the contact information registered with Device Setup to another device.

Note
When you copy the contact information between the devices whose maximum allowed registration number 
of contact information is different, the number of contact information is limited to the maximum allowed 
number that the target device supports.
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1.In tree view, expand [Settings]＞ [Scanner/Fax-Specific Settings] > [Contact Information], followed
by the device that includes the recipients to be copied＞ and then select [Contact List].
To copy contact information individually, select the recipients in tree view or list view. 

2.Select [Copy Contact] from the [Service] menu. 

3. In tree view, expand the device to which to copy contact information, and then select [Contact List].

4.Select [Paste Contact] from the [Service] menu.

The contact information is pasted into the contact list.

Note
At this point, the contact information has not been set on the device. Set it on the device, as needed. For 
instructions, refer to "Reflecting Your Settings in Devices" (P.102).
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Exporting and Importing the Contact Information
You can export the contact information for a device registered with Device Setup to a file. You can also 
import the exported file to Device Setup.
This function is useful when you want to use the same contact information in Device Setup on another 
PC.

Important
Device Setup exports the file in a format unique to itself. Do not edit the file using other applications.

Note
The extension of the exported contact information file is “mb9” (a format unique to Device Setup).

Exporting the Contact Information to a File

1. In tree view, expand [Settings]＞ [Scanner/Fax-Specific Settings] > [Contact Information], and then
select the device.

2.Select [Export Contact] from the [Service] menu.
The [Contact Information - Export Check] dialog box appears. 

3.Check the contents of the [Contact Information-Export Check] dialog box, and click [Yes].

The [Save As] dialog box appears.
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4.Specify the filename and storage location, and then click [Save].

A contact information file with extension “mb9” (a format unique to Device Setup) is created in the 
specified location.

Importing the Contact Information File into Device Setup
To import the contact information file you exported in the previous section into Device Setup, follow the 
procedure below.

1.In tree view, expand [Settings]＞ [Scanner/Fax-Specific Settings] > [Contact Information], and then
select the device. 

2.Select [Import Contact] from the [Service] menu.
The [Contact Information - Import Check] dialog box appears. 

3.Check the contents of the [Contact Information - Import Check] dialog box, and click [Yes].

The [Open] dialog box appears.

4.Browse to the location into which the contact information file was exported in the previous section.
Select the contact information file (“mb9” extension), and then click [Open].
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The [Contact information contents confirmation] dialog box appears. 

5.Check if there is no wrong information on the contact information to import to Device Setup.
After checking the information, click [OK].

The [Contact Information - Confirm Overwrite] dialog box appears.

6.Select whether to overwrite the contact information or not, and click [OK].

A confirmation message appears. 

Note
You cannot edit part of the contact information. In that case, edit the contact information on Device Setup.
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7.Click [OK].

The contact information imported from the file are displayed in [Contact List].

Note
At this point, the contact information has not been set on the device. Set it on the device, as needed. For 
instructions, refer to "Reflecting Your Settings in Devices" (P.102).
If your device does not have relevant features, an error will occur at the time you attempt to set them for the 
device.

Using the Contact Information

See
Before proceeding, make sure to set the contact information on the device. For more information, refer to 
"Reflecting Your Settings in Devices" (P.102).

1.Load the document on the device. 

2.Press the [All Services] button on the control panel of the device, and tap [Fax / Internet Fax].

3.Tap [Enter Fax Number], and specify the recipient.

4.Tap [Done] > [Send].

See
The procedure may differ depending on the device in use. For more instructions, refer to the manual of the 
device.
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Creating the Contact Information All at Once
Device Setup InputTool and Device Setup allow you to create multiple contact information all at once. 
This is useful, for example, when you want to register multiple contact information with a single device.
Device Setup InputTool is a file in the Microsoft Excel workbook format.
To enter multiple contact information in the provided Excel sheet, export data, and import the exported 
data into Device Setup to create contact information all at once, follow the procedure below.

Note
Device Setup InputTool allows you to create many settings all at once by using Microsoft Excel. When saving 
Device Setup InputTool containing those settings, make sure to save it in a safe way to avoid personal 
information from being compromised. For example:
･ Using a Zip file with a password
･ Saving in a folder where access permissions are set

Creating Batch Input File Using Device Setup InputTool
“Device Setup InputTool - Contact Information.xls” is composed of only the Excel sheet "Contact
Information". This input tool allows you to import Address Book data you registered, set, or changed with
"Device Setup InputTool - Address Book. xls or "Device Setup" as Contact Information data.

Important
Device Setup exports the file in a format unique to itself. Do not edit the file using other applications.

Note
･ The extension of the exported batch input file is “mb9” (a format unique to Device Setup).
･ Address numbers cannot be set with the Contact Information feature.

1.From the Windows [Start] menu, select [FUJIFILM] >[Device Setup InputTool].
The [InputTool] window appears. 

2.Double click the “Device Setup InputTool - Contact Information.xls” file.

Note
･ Device Setup InputTool uses macros. To use this tool, you need to specify [Medium] or less for the security 

level of Microsoft Excel. When [Medium] is specified, a message confirming the execution of a macro is 
displayed. Click [Enable Macros].
･ Double clicking “Usage of Device Setup InputTool.txt” displays the additional information and restrictions 

for Device Setup InputTool. 
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See
For information on the Excel versions supported by Device Setup InputTool, refer to "Required System 
Environment" (P.19).

3.Enter the Contact Information to create, one recipient per row.

Note
･ Some items in the [Add Contact] dialog box are not included in “Device Setup InputTool - Contact 

Information.xls”. When you export the data, these items are assigned default values. If you want to change 
attribute values for the items that are not included in “Device Setup InputTool - Contact Information. xls”, 
use Device Setup to edit them.
･ If you leave optional items blank in "Device Setup InputTool - Contact Information. xls”, these items are also 

assigned default values when you export the data.
･ The maximum number of contact information allowed varies depending on the device.
･ Selecting [Skip] in the [Data Processing] column will prevent the data being verified and exported to a file.

See
For information on what information you need to enter in each of the cells, refer to the Help displayed when 
you click the header cell.

4.After completing entering the data, click [▼ ] for the cell in the [Data Processing] column on the last 
row you entered, and then select [End of Data].

Note
･When you click [Check Data] or [Export Data] without setting the [End of Data] row, an error occurs.
･ You can check if the values entered so far in the cells are correct by clicking [Check Data]. This check is the 

same as the one performed when you click [Export Data] in Step 5. 

5.Click [Export Data].
If a value is incorrect, the error cell is highlighted, and the error message appears. If there is no error, the 
[Save As] dialog box appears.
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6.Specify the filename and storage location, and then click [Save].

The [Data Export] message appears.

7.Click [OK].
The batch input file with “mb9” extension (a format unique to Device Setup) is created in the specified 
location.
The original workbook provided for the product cannot be overwritten. To save the data you entered, 
select [Save As] from the [File] menu, and specify a file name.

Note
Save the file in a folder where access permissions are set, which is located in a different place than the Device 
Setup installation folder.

8.Select [Close] from the [File] menu.
Device Setup InputTool is exited.

Importing the Batch Input File Using Device Setup

See
Refer to "Importing the Contact Information File into Device Setup" (P.76).

Setting Address Group
See
For an overview of Address Group, refer to "Creating Address Group" (P.16).

This section explains the following items:
 How to set an address group for a device
 How to export the address group to a file, and how to import it into Device Setup
 How to create address groups all at once

Setting Address Group for a Device
You can add address groups on Device Setup by either of the following ways:
 Create a new address group
 Copy an address group
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Creating a New Address Group

1.In tree view, expand [Settings] > [Scanner/Fax-Specific Settings] > [+] at [Address Group], and then
select the device. 

2.Select [Add Group] from the [Service] menu. 
The [Add Group] dialog box appears.

3.Set each of the items.

4.Click [OK].

A new address group is created.

Note
At this point, the address group have not been set on the device. Perform the procedure in "Reflecting Your 
Settings in Devices" (P.102), as needed.
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Copying an Address Group
You can copy address groups registered with Device Setup to another device.

Note
When you copy address group between the devices whose maximum allowed registration number of address 
groups is different, the number of address groups is limited to the maximum allowed number that the target 
device supports.

1.In tree view, expand [Settings] > [Scanner/Fax-Specific Settings] > [+] at [Address Group] > [+] at the
original device to be copied, and then select [Address Group List].

Note
To copy Address group individually, select the recipients in tree view or list view. 

2.Select [Copy Group] from the [Service] menu. 

3.Select [+] at the device that is the copy destination, and then [Address Group List] in the tree view. 
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4.Select [Paste Group] from the [Service] menu.

The address group is pasted.

Note
At this point, the address group have not been set on the device. Perform the procedure in "Reflecting Your 
Settings in Devices" (P.102), as needed.

Exporting and Importing Address Group
You can export address group for a device registered with Device Setup to a file. You can also import the 
exported file to Device Setup.
This function is useful when you want to use the same address group in Device Setup on another PC.

Important
Device Setup exports the file in a format unique to itself. Do not edit the file using other applications.

Note
The extension of the exported address group file is “mb10” (a format unique to Device Setup).

Exporting Address Group to a File

1. In tree view, expand [Settings] > [Scanner/Fax-Specific Settings] > [+] at [Address Group], and then
select the device. 
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2.Select [Export Group] from the [Service] menu.
The [Save As] dialog box appears. 

3.Specify the location and file name for saving the file, and then click [Save].
An address group file whose extension is "mb10", unique format to Device Setup, is created in the 
specified location.

Importing the Address Group File into Device Setup

1.In tree view, expand [Settings] > [Scanner/Fax-Specific Settings] > [Address Group], and then select
the device.

2.Select [Import Group ] from the [Service] menu.
The [Open] dialog box appears. 

3.Browse to the location into which the address group file was exported in the previous section.
Select the file whose extension is "mb10", and then click [Open].
The [Group Name information contents confirmation] dialog box appears. 

4.Make sure there is no problem, and click [OK]. 
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5.Select whether to overwrite the address group or not, click [OK].

The address group imported from the file are displayed in [Address Group List].

Note
At this point, the address group have not been set on the device. Perform the procedure in "Reflecting Your 
Settings in Devices" (P.102), as needed.
If your device does not have relevant features, an error will occur at the time you attempt to set them for the 
device.

Creating Address Groups All at Once
Device Setup InputTool allows you to create multiple address groups all at once.
This is useful, for example, when you want to register multiple address groups with a single device.
Device Setup InputTool is a file in the Microsoft Excel workbook format.

Create Batch Input File Using Device Setup InputTool
“Device Setup InputTool - Address Group.xls” is composed of only the Excel sheet "Address Group".

Important
Device Setup exports the file in a format unique to itself. Do not edit the file using other applications.

Note
･ Address groups you change at the device or on Device Setup are not reflected in Device Setup InputTool. 

Therefore, the content in the Excel sheet may be different from the latest settings of the device.
･ The extension of the exported batch input file is “mb10” (a format unique to Device Setup).
･ Speed Dials cannot be set with the Address Group feature.
･  You cannot add recipients to the address group with Device Setup InputTool. Set the contact information 

in the device once and then add the address book with Device Setup.
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1.From the Windows [Start] menu, select [FUJIFILM] > [Device Setup InputTool].
The [InputTool] window appears.

2.Double click the “Device Setup InputTool - Address Group.xls” file.

Note
･ Device Setup InputTool uses macros. To use this tool, you need to specify [Medium] or less for the security 

level of Microsoft Excel. When [Medium] is specified, a message confirming the execution of a macro is 
displayed. Click [Enable Macros].
･ Double clicking “Usage of Device Setup InputTool.txt” displays the additional information and restrictions 

for Device Setup InputTool.

See
For information on the Excel versions supported by Device Setup InputTool, refer to "Required System 
Environment" (P.19).

3.Enter the address group information to create, one group per row.

Note
･ The maximum number of address groups allowed varies depending on the device.
･ Selecting [Skip] in the [Data Processing] column will prevent the data being verified and exported to a file.

See
For information on what information you need to enter in each of the cells, refer to the Help displayed when 
you click the header cell.

4.After completing entering the data, click [▼ ] for the cell in the [Data Processing] column on the last 
row you entered, and then select [End of Data].

Note
･When you click [Check Data] or [Export Data] without setting the [End of Data] row, an error occurs.
･ You can check if the values entered so far in the cells are correct by clicking [Check Data]. This check is the 

same as the one performed when you click [Export Data] in Step 5.

5.Click [Export Data].
If a value is incorrect, the error cell is highlighted, and the error message appears. If there is no error, the 
[Save As] dialog box appears.

6.Specify the filename and storage location, and then click [Save].
The [Data Export] message appears.
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7.Click [OK].
The batch input file with “mb10” extension (a format unique to Device Setup) is created in the specified 
location.

8.Select [Close] from the [File] menu.
Device Setup InputTool is exited.

Import Batch Input File Using Device Setup

See
Refer to "Importing the Address Group File into Device Setup" (P.85).

Setting Fax Comments
For an overview of fax comments, refer to "Creating Internet Fax Comment" (P.16).

Setting Fax Comments for a Device
Creating a New Fax Comment

1.In tree view, expand [Settings] > [Scanner/Fax-Specific Settings] > [+] at [FaxComment], and then
select the device. 

2.Select [Create Fax Comment] from the [Service] menu. 
The [Create Fax Comment] dialog box appears.
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3.Set each item, and then click [OK].

A new fax comment is created.

Note
At this point, the fax comments have not been set on the device. Perform the procedure in "Reflecting Your 
Settings in Devices" (P.102), as needed.

Copying a Fax Comment
You can copy fax comments registered with Device Setup to another device.

Note
When you copy fax comments between the devices whose maximum allowed registration number of fax 
comments is different, the number of fax comments is limited to the maximum allowed number that the 
target device supports.
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1. In tree view, expand [Settings] > [Scanner/Fax-Specific Settings] > [+] at [FaxComment] > [+] at the
original device to be copied, and then select [Fax Comment List].

Note
To copy fax comments individually, select the fax comments in tree view or list view. 

2.Select [Copy Fax Comment] from the [Service] menu. 

3.Select [+] at the device that is the copy destination > [Fax Comment List] in the tree view.
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4.Select [Paste Fax Comment] from the [Service] menu.

The fax comments are pasted.

Note
At this point, the fax comments have not been set on the device. Perform the procedure in "Reflecting Your 
Settings in Devices" (P.102), as needed.

Exporting and Importing Fax Comments
You can export fax comments for a device registered with Device Setup to a file.
You can also import the exported file to Device Setup. This function is useful when you want to use the 
same fax comments in Device Setup on another PC.

Important
Device Setup exports the file in a format unique to itself. Do not edit the file using other applications.

Note
The extension of the exported fax comments file is “mb7” (a format unique to Device Setup).

Exporting Fax Comments to a File

1. In tree view, expand [Settings] > [Scanner/Fax-Specific Settings] > [+] at [FaxComment], and then
select the device. 



92

2.Select [Export Fax Comment] from the [Service] menu.
The [Save As] dialog box appears. 

3.Specify the filename and the storage location, and then click [Save].
A file whose extension is "mb7", unique format to Device Setup, is created in the specified location.

Importing the Fax Comments File into Device Setup

1.In tree view, expand [Settings] > [Scanner/Fax-Specific Settings] > [+] at [FaxComment], and then
select the device. 

2.Select [Import Fax Comment] from the [Service] menu.
The [Open] dialog box appears. 

3.Browse to the location into which the fax comments file was exported in the previous section.
Select the file whose extension is "mb7", and then click [Open]. 

4.Make sure there is no problem, and click [OK].
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5.Select whether to overwrite the fax comment or not, click [OK]. 

6.Click [OK] on the confirmation message.
The fax comments imported from the file are displayed in [Fax Comment List].

Note
At this point, the fax comments have not been set on the device. Perform the procedure in "Reflecting Your 
Settings in Devices" (P.102), as needed.
If your device does not have relevant features, an error will occur at the time you attempt to set them for the 
device.

Creating Multiple Fax Comments All at Once
Device Setup InputTool allows you to create multiple fax comments all at once. This is useful, for 
example, when you want to register multiple fax comments with a single device.
Device Setup InputTool is a file in the Microsoft Excel workbook format.

Creating Batch Input File Using Device Setup InputTool

Important
Device Setup exports the file in a format unique to itself. Do not edit the file using other applications.

Note
･ Fax comments you change at the device or on Device Setup are not reflected in Device Setup InputTool. 

Therefore, the content in the Excel sheet may be different from the latest settings of the device.
･ The extension of batch input file is "mb7", the unique format to Device Setup.

1.From the Windows [Start] menu, select [FUJIFILM] > [Device Setup InputTool].
The [InputTool] window appears. 
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2.Double click the “Device Setup InputTool - FaxComment.xls” file.

Note
･ Device Setup InputTool uses macros. To use this tool, you need to specify [Medium] or less for the security 

level of Microsoft Excel. When [Medium] is specified, a message confirming the execution of a macro is 
displayed. Click [Enable Macros].
･ Double clicking “Usage of Device Setup InputTool.txt” displays the additional information and restrictions 

for Device Setup InputTool. 

See
For information on the Excel versions supported by Device Setup InputTool, refer to "Required System 
Environment" (P.19).

3.Enter the fax comments information to create, one comment per row.

Note
The maximum number of fax comments allowed varies depending on the device.

See
For information on what information you need to enter in each of the cells, refer to the Help displayed when 
you click the header cell. 

4.After completing entering the data, click [▼ ] for the cell in the [Data Processing] column on the last 
row you entered, and then select [End of Data].

Note
･When you click [Check Data] or [Export Data] without setting the [End of Data] row, an error occurs.
･ You can check if the values entered so far in the cells are correct by clicking [Check Data]. This check is the 

same as the one performed when you click [Export Data] in the next step.

5.Click [Export Data].
The values in the cells are verified. If a value is incorrect, the error cell is highlighted, and the error 
message appears. If there is no error, the [Save As] dialog box appears. 

6.Specify the filename and storage location, and then click [Save]. 

7.Click [OK] on the [Data Export] message.
The batch input file with “mb7” extension (a format unique to Device Setup) is created in the specified 
location. 

8.Select [Close] from the [File] menu.
Device Setup InputTool is exited.



5 　Registering Devices with Device Setup

95

Importing the Batch Input File Using Device Setup

See
Refer to "Importing the Fax Comments File into Device Setup" (P.92).

Setting Folder Selectors 
For an overview of folder selectors, refer to "Creating Folder Selector" (P.17).

Setting Folder Selectors for a Device
Creating a New Folder Selector

1. In tree view, expand [Settings] > [Scanner/Fax-Specific Settings] > [+] at [Folder Selector], and then
select the device. 

2.Select [Create Folder Selector] from the [Service] menu. 
The [Create Folder Selector] dialog box appears.
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3.Set each item, and then click [OK].

A new folder selector is created.

Note
At this point, the folder selector has not been set on the device. Perform the procedure in "Reflecting Your 
Settings in Devices" (P.102), as needed.

Copying Folder Selectors
You can copy folder selectors registered with Device Setup to another device.

Note
When you copy folder selectors between the devices whose maximum allowed registration number of folder 
selectors is different, the number of folder selectors is limited to the maximum allowed number that the 
target device supports.
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1.In tree view, expand [Settings] > [Scanner/Fax-Specific Settings] > [+] at [Folder Selector] > [+] at the
original device to be copied, and then select [Folder Selector List].

Note
To copy folder selectors individually, select the folder selectors in tree view or list view. 

2.Select [Copy Folder Selector] from the [Service] menu. 

3.Select [+] at the device that is the copy destination > [Folder Selector List] in the tree view.
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4.Select [Paste Folder Selector] from the [Service] menu.

The folder selectors are pasted.

Note
At this point, the folder selectors have not been set on the device. Perform the procedure in "Reflecting Your 
Settings in Devices" (P.102), as needed.

Exporting and Importing Folder Selectors
You can export folder selectors for a device registered with Device Setup to a file. You can also import 
the exported file to Device Setup. This function is useful when you want to use the same folder selectors 
in Device Setup on another PC.

Important
Device Setup exports the file in a format unique to itself. Do not edit the file using other applications.

Note
The extension of the exported folder selector file is “mb8” (a format unique to Device Setup).

Exporting Folder Selectors to a File

1. In tree view, expand [Settings] > [Scanner/Fax-Specific Settings] > [+] at [Folder Selector], and then
select the device.

2.Select [Export Folder Selector] from the [Service] menu.
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The [Save As] dialog box appears. 

3.Specify the location and file name for saving the file, and then click [Save].
A file whose extension is "mb8", unique format to Device Setup, is created in the specified location.

Importing the Folder Selector File into Device Setup

1.In tree view, expand [Settings] > [Scanner/Fax-Specific Settings] > [+] at [Folder Selector], and then
select the device. 

2.Select [Import Folder Selector] from the [Service] menu.
The [Open] dialog box appears. 

3.Browse to the location into which the folder selectors file was exported in the previous section.
Select the file whose extension is "mb8", and then click [Open]. 

4.Make sure there is no problem, and click [OK].
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5.Select whether to overwrite the folder selector or not, click [OK]. 

6.Click [OK] on the confirmation message.

The folder selectors imported from the file are displayed in [Folder Selector List].

Note
At this point, the folder selectors have not been set on the device. Perform the procedure in "Reflecting Your 
Settings in Devices" (P.102), as needed.
If your device does not have relevant features, an error will occur at the time you attempt to set them for the 
device.

Creating Multiple Folder Selectors All at Once
Device Setup InputTool allows you to create multiple folder selectors all at once. This is useful, for 
example, when you want to register multiple folder selectors with a single device.
Device Setup InputTool is a file in the Microsoft Excel workbook format.

Creating Batch Input File Using Device Setup InputTool

Important
Device Setup exports the file in a format unique to itself. Do not edit the file using other applications.

Note
･ Folder selectors you change at the device or on Device Setup are not reflected in Device Setup InputTool. 

Therefore, the content in the Excel sheet may be different from the latest settings of the device.
･ The extension of batch input file is "mb8", the unique format to Device Setup.

1.From the Windows [Start] menu, select [FUJIFILM] >[Device Setup InputTool].
The [InputTool] window appears. 
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2.Double click the “Device Setup InputTool - FolderSelector.xls” file.

Note
･ Device Setup InputTool uses macros. To use this tool, you need to specify [Medium] or less for the security 

level of Microsoft Excel. When [Medium] is specified, a message confirming the execution of a macro is 
displayed. Click [Enable Macros].
･ Double clicking “Usage of Device Setup InputTool.txt” displays the additional information and restrictions 

for Device Setup InputTool.

See
For information on the Excel versions supported by Device Setup InputTool, refer to "Required System 
Environment" (P.19).

3.Enter the folder selectors information to create, one selector per row.

Note
The maximum number of folder selectors allowed varies depending on the device.

See
For information on what information you need to enter in each of the cells, refer to the Help displayed when 
you click the header cell. 

4.After completing entering the data, click [▼ ] for the cell in the [Data Processing] column on the last 
row you entered, and then select [End of Data].

Note
･When you click [Check Data] or [Export Data] without setting the [End of Data] row, an error occurs.
･ You can check if the values entered so far in the cells are correct by clicking [Check Data]. This check is the 

same as the one performed when you click [Export Data] in the next step. 

5.Click [Export Data].
The values in the cells are verified. If a value is incorrect, the error cell is highlighted, and the error 
message appears. If there is no error, the [Save As] dialog box appears. 

6.Specify the filename and storage location, and then click [Save]. 

7.Click [OK] on the [Data Export] message.
The batch input file with “mb8” extension (a format unique to Device Setup) is created in the specified 
location. 

8.Select [Close] from the [File] menu.
Device Setup InputTool is exited.
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Importing the Batch Input File Using Device Setup

See
Refer to "Importing the Folder Selector File into Device Setup" (P.99).

Reflecting Your Settings in Devices
This section explains how to reflect the settings configured with Device Setup in devices. Reflect the 
settings on a service-by-service basis.

Important
Do not use Device Setup to configure or delete the attribute values of the device while someone is operating 
the device control panel to set the device settings. Otherwise, a message indicating that "Current settings 
must be reset as registered data has been updated by an operation from an external machine.” appears on 
the device control panel, and this may cause other operations except for the restarting of the device to be 
prohibited.

Note
･ For the following services, when the settings are applied to a device, the device is rebooted automatically. 

If the device is in use and therefore cannot be rebooted, a message is displayed prompting you to reboot 
the device by switching off the device first before switching it on again. 
When this happens, reboot the device as instructed.
･ Basic Information service (Machine E-mail Address, Enable Port, Protocol Settings settings)
･ Access Permissions service (Login Setup / Accounting, Access Permissions, IP Address settings)
･ Address Book/Contact Information services (Address Book/Contact Information settings)

･When you attempt to set attribute values to a device, the system checks whether the attribute values to be 
set by Device Setup match the ones set on the device. If they do not match, a message appears to check 
whether to overwrite the attributes set on the device.
However, if the attribute values are passwords, the system cannot check whether the attribute values to be 
set by Device Setup match the ones set on the device. Accordingly, the passwords are set as follows:
･ Encrypted passwords are always overwritten.
･ Passwords set by Device Setup are always overwritten.
･ For devices that cannot send passwords in an encrypted format, blank passwords are retrieved from

the devices. When the passwords left blank are set to the device, the passwords on the device are not
overwritten.

1.In tree view or list view, select the device below the service.

Note
In list view, multiple devices can be selected. To select multiple devices, click the devices while pressing the 
<Shift> or < Ctrl> key on the keyboard. 

2.Select [Save Attributes to Device] from the [Edit] menu.
A dialog box appears to confirm if you want to apply the settings. 
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3.Click [Yes].

The settings are reflected in the device. The icon status of the device changes from [Modifying] to 
[Saved/Retrieved] and the attribute status also changes from [Modifying] to [Original].
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6Exporting/Importing Device 
Settings

Exporting Device Settings to a File
This section explains how to export device settings for each of the Device Setup services.
You can save the settings configured with Device Setup to a file on a service-by-service basis. Any items 
registered with the service, including the devices, mailboxes, address book/contact information, and job 
flow sheets, will also be saved.
This file is called a device settings file. The device settings file can be used as follows: 
 Import the saved device settings file to Device Setup for use 
 Import the device settings file to Device Setup installed on another PC for use

Extension and File Name of Device Settings File
The file extension of the device settings file is "mb1" (format unique to Device Setup).
The default names of the various device settings files are as follows:

Basic Information DeviceSettingBasic.mb1

Access Permissions DeviceSettingAccessLimitation.mb1

Mailbox DeviceSettingPrivateBox.mb1

Address Book DeviceSettingAddress.mb1

Contact Information DeviceSettingNewAddress.mb1

Job Flow Sheet DeviceSettingJobTemplate.mb1

Job Log Analysis DeviceAnalysisJob.mb1

Fax Group DeviceSettingGroupDial.mb1

Address Group DeviceSettingNewGroupDial.mb1

Folder Selector DeviceSettingBoxSelector.mb1

Fax Comment DeviceSettingFaxComment.mb1
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Exporting Device Settings to a File
To export device settings form Device Setup to a file, follow the procedure below.

Important
Device Setup exports the file in a format unique to itself. Do not edit the file using other applications.

Note
･ After you have exported device settings to a file, if you plan to change the encryption key for confidential

data of the device, make sure to note the old key. Changing the encryption key for confidential data will
prevent you from applying attributes within the device settings file that contain the encrypted password to
the device. For more information, refer to "Changing Encryption Key for Confidential Data" (P.155).
･ Device settings files cannot be imported to Device Setup whose version is older than that from which the

device settings files were created.

1.Expand tree view, and select a service. 

2.Select [Export Device Settings] from the [File] menu.
The [Save As] dialog box appears. 

3.Specify the location and file name for saving the file, and then click [Save].
The device settings file is created in the specified location.

Importing Device Settings Files to Device Setup
This section explains how to import the exported device settings files to Device Setup.
By selecting a service and importing the device services file, you can make use of the device settings that 
are saved in the file.

Note
Device settings files exported from a newer version of Device Setup than the one currently installed cannot 
be imported.
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Importing Device Settings Files to Device Setup
To import a device settings file to Device Setup service, follow the procedure below.

1.Expand tree view, and select a service. 

2.Select [Import Device Settings] from the [File] menu.
The [Open] dialog box appears. 

3.Select the device settings file for the service selected in Step 1. 

4.Click [Open].
The [Import Device Settings] dialog box appears.

5.Select whether to add settings to the current settings of the service or completely replace with the 
content of the new settings file.

 [Add settings to existing device]
If there is the same IP address or host name in the currently registered device and the device of the 
device settings file, the currently registered device will be deleted, and the device in the device settings 
file will be registered.

 [Overwrite existing device settings]
All currently registered devices will be deleted and only the device in the device settings file will be 
registered. 

6.Click [OK].
The content of the device settings file will be imported into the Device Setup service.



7 　Restricting Use/Checking Usage of Devices

107

7Restricting Use/Checking Usage 
of Devices

Restricting Access to Devices
This section explains the overview of the Access Permissions service and the settings of the usage 
restriction.
You can use the Access Permissions service of Device Setup to configure the following two types of 
settings for devices:
Restrict use by user 
 Set login setup / Accounting mode of devices
Restrict by IP address and e-mail address 
 Access-permitted sender’s IP address 
 Access-permitted or -rejected sender’s domain

Access Permissions Service
You can use the Access Permissions service to set the following usage restrictions:

Login Setup / Accounting Mode
The Login Setup feature is for limiting the use of the device to users registered with the device.
Users need to enter the User ID and password when using the device.

The Accounting feature is for managing the usage of each feature of the device per user.
It can check the number of pages copied in color or black and white separately, or restrict users that can 
copy in color or print in color.
The settings of login setup and accounting mode for each user can be configured individually as well as 
all at once. To configure the settings all at once, create “User information batch input file” using Device 
Setup InputTool, and import the data using Device Setup. 

User ID: Fuji Taro
Password: ***********
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Access-permitted Sender’s IP Address
Restrict the communication with your device by designating the sender's IPv4 or IPv6 addresses This is 
applicable to all transmissions using Internet Protocol (IP), such as SNMP, POP3, LPR, SOAP (e.g. Device 
Setup), and HTTP (e.g. Internet Services).

Important
Ensure that you add the access-permitted IP address before enabling the IP address restriction. If you enable 
the IP access restriction when there is no access-permitted IP address designated, any user cannot access 
the device using TCP/IP in any way.

Access-permitted or -rejected sender’s domain name
Restrict incoming e-mails by designating the sender’s domain name (domain name in the "FROM" field). 

Types of Login Setup / Accounting Mode
Depending on the device type, either one or the followings can be set up on the device using Device 
Setup. 
 [Login to Local Accounts], [Login to Network Accounts], [Login to Remote Accounts]
 [No Login Required/Network Accounting], [Login to Local Accounts/Local Accounting], [Login to 

Local Accounts/Network Accounting], [Login to Remote Accounts/Accounting Disabled], [Login to 
Remote Accounts/Network Accounting]

Note
Depending on the model, you may be able to select the Login to Remote Accounts option on the device 
control panel, even though the option is not available in Device Setup. If you select the Login to Remote 
Accounts option on such a device, the following restrictions are applied.
･ Attribute values for the Login Setup/Accounting Mode setting and user information cannot be retrieved

with Device Setup.
･ Attribute values for the Login Setup/Accounting Mode setting and user information cannot be set from

Device Setup to the device.

OK

Determined by sender’s IP address

172.*.*.*
2001:DB8:1001

NO 192.168.0.*
2001:DB8:1000:*

OK

Determined by the domain name of sender’s address (FROM field)

NO

FROM: Fuji Taro@mycompany.com 

FROM: somebody@nowhere.org
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When [Login Setup / Accounting Mode] is set to [Login to Local Accounts],
[Login to Network Accounts], [Login to Remote Accounts]

Login to local accounts
Login authentication and account administration are performed using the user details registered with 
the device. You can register users, display user details, delete users, and manage accounting (e.g. 
checking the accumulated pages by users) with the following:
 Device Setup
 Control panel of device
 Internet Services

Login to Network Accounts
Login authentication is performed using the user details registered with the device. Accounting is 
performed using ApeosWare Management Suite.
 You can register users, display user details, and delete users using software such as Device Setup and 

ApeosWare Management Suite.  User details cannot be managed from the device control panel or 
Internet Services.

 Account ID is added to user details. Account ID can be used to specify the department for billing or 
the project code.

Login to remote accounts
Login authentication is performed using the user details registered with the remote authentication 
server. Accounting is performed using ApeosWare Management Suite. User details and accounting 
cannot be managed by the device control panel, Device Setup, and Internet Services.

When [Login Setup / Accounting Mode] is set to [No Login Required/Network
Accounting], [Login to Local Accounts/Local Accounting], [Login to Local
Accounts/ Network Accounting], [Login to Remote Accounts/Accounting
Disabled], [Login to Remote Accounts/Network Accounting]

No Login Required/Network Accounting
Login authentication is not required on the device. Accounting is performed using ApeosWare 
Management Suite. The registered user details are used only for accounting.
 Accounting (e.g. checking the accumulated pages by users) and creating the accounting report are 

performed using ApeosWare Management Suite.
 You can register users, display user details, and delete users using software such as Device Setup and 

ApeosWare Management Suite. User details cannot be managed from the device control panel or 
Internet Services.

 Account ID is added to user details. Account ID can be used to specify the department for billing or 
the project code.

Login to Local Accounts/Local Accounting
Login authentication and account administration are performed using the user details registered with 
the device. You can register users, display user details, delete users, and manage accounting with the 
following:
 Device Setup
 Control panel of device
 Internet Services
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Login to Local Accounts/Network Accounting
Login authentication is performed using the user details registered with the device. Accounting is 
performed using ApeosWare Management Suite.
 You can register users, display user details, and delete users using software such as Device Setup and 

ApeosWare Management Suite. User details cannot be managed from the device control panel or 
Internet Services.

 Account ID is added to user details. Account ID can be used to specify the department for billing or 
the project code.

Login to Remote Accounts/Accounting Disabled
Login authentication is performed using the user details registered with the remote authentication 
server. Accounting is not performed. User details and accounting cannot be managed by the device 
control panel, Device Setup, and Internet Services.

Login to Remote Accounts/Network Accounting
This item is displayed only when you have retrieved attribute values from a device for which ApeosWare 
Authentication Agent is set as its remote authentication server. Login authentication is performed using 
the user details registered with ApeosWare Authentication Agent. User details and accounting cannot 
be managed by the device control panel, Device Setup, and Internet Services.

Setting Usage Restriction
From Device Setup, configure login setup / accounting mode settings for a device, and then register 
users to apply usage restriction for the device.
Here, we use the following example to register different users after setting login setup / accounting 
mode at the device.

To restrict features available on the device per user, perform the procedure in the following order:
 Configure login setup / accounting mode on the device
 Register users that are allowed to use the device
 Restrict features that users can use

Note
If [Login to Remote Accounts] is configured as the login setup /accounting mode, users that are allowed to 
use the device will be registered with the remote authentication server. Do not register the users using Device 
Setup.

Registered User Restriction

Manager No restriction

General staff A Can create up to 1,000 copies of black and white copies /prints. Cannot create any color
output. Restriction for fax and scan not set.General staff B

General staff C
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Configuring Login Setup / Accounting Mode for the Device
From Device Setup, configure Login Setup / Accounting Mode for the device.

1.In tree view, expand [Settings] > [General Device Settings]＞ [Access Permissions], and then select
the device to be configured.

2.Select [Login Setup / Accounting Mode] from the [Service] menu.
The [Login Setup / Accounting Mode] dialog box appears. 

3.Configure each of the items in the[Login Setup / Accounting Mode] dialog box.
In the [Login Setup / Accounting Mode] drop-down list, items of either one of the following two types 
appear depending on the device type. 
 [No Login Required], [Login to Local Accounts], [Login to Network Accounts], [Login to Remote 

Accounts] 
 [No Login Required/Accounting Disabled], [No Login Required/Network Accounting], [Login to Local 

Accounts/Local Accounting], [Login to Local Accounts/ Network Accounting], [Login to Remote 
Accounts/Accounting Disabled], [Login to Remote Accounts/Network Accounting] 

1. Select the type of login setup. In this example, we select [Login to Local Accounts] or [Login to
Local Accounts/Local Accounting].

Note
Selecting [No Login Required] or [No Login Required/Accounting Disabled] will disallow user details to
be added. 

(1)

(2)

(3)
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2. Select the function for the login setup / accounting mode. In this example, copier, printer, scanner
and fax will be selected for the login setup / accounting mode. 

3. Configure whether to enter a password when using the device. In this example, we select to enter
a password.

See
For information on the other items, refer to the online Help in the [Login Setup / Accounting Mode] dialog
box. 

4.Click [OK]. 

Registering Users That Are Allowed to Use the Device
From Device Setup, register users with the device for which Login Setup / Accounting Mode has already 
been configured.

1.In tree view, expand [Settings] > [General Device Settings]＞ [Access Permissions], and then select
the device that has been configured with Login Setup / Accounting Mode. 

2.Select [Add User Details] from the [Service] menu.
The [Add User Details] dialog box appears. 

3.Configure the individual items of the [Add User Details] dialog box. 

1. Set User ID of between 1 and 32 characters. The following single-byte characters can be used:
Alphanumeric characters, spaces, and the following symbols: ! # $ % & ' （ ） * , - . / : = @ ￥ ^ _ ~ 

Note
User details with User ID identical to that of the system administrator's of the device cannot be set to the
device. If the User ID is identical to the system administrator ID, clicking [Save to Device] will result in an
error.

(1)

(2)

(3)

(4)
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2. Enter the user name with up to 32 characters.
3. Enter a password of between 4 and 12 alphanumeric characters in length. Click [Edit Password]

before you can enter the password.

See
For information on how to edit the password, refer to "Editing Passwords" (P.154). 

4. To confirm, enter the same password as above.

See
For information on other items, refer to the online Help in the [Add User Details] dialog box. 

4.Click [OK]. 

5.By repeating Steps 2 to 4, you can add as many users.as you want.
Here, add in the order of General staff B, General staff C and Manager.

Note
If you set the user details added with Device Setup to the device at this point, you will need to log in to use 
the device.

Restricting Features That Users Can Use
You can configure the types of copy, fax, print and scan that are allowed to be used, and the upper limit 
of the number of output impressions.
To set General staffs A, B and C all at once, follow the procedure below. In this example, as you do not 
set restriction to the manager, there is no need to configure any settings.

1.In tree view, expand [Settings] > [General Device Settings]＞ [Access Permissions]＞ device＞ [User
Details List], and then select the General staff A, B, C together from list view.

2.Select [Edit User Permissions] from the [Service] menu.
The [Edit User Permissions] dialog box appears.
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3.Configure the individual items of the [Edit User Permissions] dialog box. 

1. For both [Copy] and [Print] for General staffs A, B and C, select [Black Only]. For [Scanner] and
[Fax], select [Free Access].

Note
Here, you can also configure settings to restrict the use of copier, fax, printer, scanner. 

2. For both [Black Copy] and [Black Print] for General staffs A, B and C, enter [1000].

See
For information on other items, refer to the online Help in the [Edit User Permissions] dialog box.

4.Click [OK].
Access permissions have now been configured. With these settings, both [Black Copy] and [Black Print] 
for General staffs A, B and C have been restricted to 1000 impressions.

Note
At this point, the access permissions information has not been set on the device. Set it on the device, as 
needed. For instructions, refer to "Reflecting Your Settings in Devices" (P.102). 

Creating Usage Restrictions All at Once
“Device Setup InputTool” and Device Setup allow you to create multiple user details as well as usage 
restrictions for each user all at once. This is useful when you want to register multiple user details and 
usage restrictions data with a single device.
Device Setup InputTool is a file in the Microsoft Excel workbook format.
To enter multiple user details and usage restrictions in the provided Excel sheet, export data, and import 
the exported data into Device Setup to create usage restrictions data all at once, follow the procedure 
below.

Note
Device Setup InputTool allows you to create many settings all at once by using Microsoft Excel. When saving 
Device Setup InputTool containing those settings, make sure to save it in a safe way to avoid personal 
information from being compromised. For example:
･ Saving as a Zip file protected with a password
･ Saving Device Setup InputTool in a folder where access permissions are set

(1)

(2)
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Creating Batch Input File Using Device Setup InputTool
“Device Setup InputTool - User Permissions.xls” is composed of the following Excel sheets. 
 NoLoginRequired

Used when you want to configure the device usage restrictions as follows: the entering of User ID and 
password is required, and the number of copies and prints are not limited. 

 LocalAccounting-Login
Used when you want to configure the device usage restrictions as follows: the entering of User ID and 
password is required, the number of copies and prints are limited, and the login setup / accounting 
mode of the device is set to [Login to Local Accounts] or [Login to Local Accounts/Local Accounting]. 

 NetworkAccounting-NoLogin|Login or NetworkAccounting-Login
Used when you want to configure the device usage restrictions as follows: the entering of User ID and 
password is required, the number of copies and prints are limited, and the login setup / accounting 
mode of a device is set to [Login to Network Accounts] and [No Login Required/Network 
Accounting]; or the entering of User ID and password is required, the number of copies and prints are 
limited, and the login setup / accounting mode of a device is set to [Login to Local Accounts/Network 
Accounting].

Important
Device Setup exports the file in a format unique to itself. Do not edit the file using other applications.

Note
･ Information on the access permissions you change at the device or on Device Setup are not reflected in

Device Setup InputTool. Therefore, the content in the Excel sheet may be different from the latest settings
of the device.
･ The extension of the exported batch input file is “mb4" (a format unique to Device Setup).

This section explains how to configure the same settings as those in "Setting Usage Restriction" (P.110) 
using the [Local Accounting-Login] sheet.

1.From the Windows [Start] menu, select [FUJIFILM] >[Device Setup InputTool].
The [InputTool] window appears. 
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2.Double click the “Device Setup InputTool - User Permissions.xls” file.

Note
･ Device Setup InputTool uses macros. To use this tool, you need to specify [Medium] or less for the security

level of Microsoft Excel. When [Medium] is specified, a message confirming the execution of a macro is
displayed. Click [Enable Macros].
･ Double clicking “Usage of Device Setup InputTool.txt” displays the additional information and restrictions

for Device Setup InputTool. 

See
For information on the Excel versions supported by Device Setup InputTool, refer to "Required System 
Environment" (P.19).

3.Select the Excel sheet to use, and enter access permissions information you want to create. Enter user 
details and usage restrictions, one data per row. Up 1000 usage restrictions data can be entered. After 
completing entering the data, click [▼ ] for the cell in the [Data Processing] column on the last row 
you entered, and then select [End of Data].

Note
You can check if the values entered so far in the cells are correct by clicking [Check Data]. This check is the 
same as the one performed when you click [Export Data] in Step 4. 

See
For information on what information you need to enter in each of the cells, refer to the Help displayed when 
you click the header cell.
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4.Click [Export Data]. At this point, the values in the cells are verified.
If a value is incorrect, the error cell is highlighted, and the error message appears. 
Enter the correct value, and then click [Export Data] again.
If a value is correct, the [Save As] dialog box appears. 

5.Specify the filename and storage location, and then click [Save].

The [Data Export] message appears. 

6.Click [OK].
The batch input file with “mb4” extension (format unique to Device Setup) is created in the specified 
location. 
The original workbook provided for the product cannot be overwritten. To save the data you entered, 
select [Save As] from the [File] menu, and specify a file name.

Note
Save the file in a folder where access permissions are set, which is located in a different place than the Device 
Setup installation folder.

7.Select [Close] from the [File] menu.
Device Setup InputTool is exited.

Importing the Batch Input File Using Device Setup
To import the batch input file exported from Device Setup InputTool into Device Setup, follow the 
procedure below.

Note
To import a batch input file, the device must be set to [Login to Local Accounts], [Login to Local Accounts/
Local Accounting], [Login to Network Accounts], [Login to Local Accounts/ Network Accounting] or [No 
Login Required/Network Accounting] corresponding to the sheet in use.
Even if you use [NoLoginRequired] sheet, the device must be set to one of them described above. 
For how to set the device, refer to ""Configuring Login Setup / Accounting Mode for the Device" (P.111).
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1.In tree view, expand [Settings] > [General Device Settings]＞ [Access Permissions], and then select
the device.

2.Select [Import User Permissions] from the [Service] menu.
The [Open] dialog box appears. 

3.Browse to the location into which the batch input file was exported in the previous section. Select the 
batch input file (extension "mb4”), and click [Open].

The [Import User Details/User Permissions] dialog box appears.
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4.Check if there is no wrong information on the user details and usage restrictions to create. After 
checking the information, click [OK].

The [Import User Details/User Permissions - Confirm Overwrite] dialog box appears. 

5.Select whether to overwrite the usage restrictions or not, and click [OK].

A confirmation message appears.

6.Click [OK].

The usage restrictions imported from the batch input file are displayed in [User Details List].

Note
At this point, the usage restrictions information has not been set on the device. Set it on the device, as 
needed. For instructions, refer to "Reflecting Your Settings in Devices" (P.102).
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Checking Usage of Devices
This section explains how to use the Job Log Analysis service with Device Setup.
Job Log Analysis service of Device Setup collects job history from devices to create charts or lists of the 
usage.

Note
･ The Job Log Analysis service provides only an overview of the usage of devices. It cannot display detailed

figures, and cannot output the job log as a file.
･ The counter information displayed in Job Log Analysis Service is different from meter readings used for

billing to customers.
･ To check the meter readings, select [Billing Meter] on the [Machine Status] screen on the device control

panel.
･ ApeosWare Management Suite, another software from our company, has the function to provide details of

the copying / printing job history.

Prerequisites of Device
To use the Job Log Analysis service to tally jobs, the device must be equipped with a hard disk.

Graphs / Lists Available in Job Log Analysis Service 
Graphs and lists that can be created with the Job Log Analysis service are as follows:

Graph
With the Job Log Analysis service, you can create the following types of graphs from job log: 
 Job Log Graph by Device (by output color)

The data will be tallied separately by output color (black, full color) in a graph with device as the 
vertical axis, and number of pages as the horizontal axis. 

 Job Log Graph by Device (by device feature)
The data will be tallied separately by device features (print, copy, fax print, scan, system sheet)in a 
graph with device as the vertical axis, and number of pages as the horizontal axis. 
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 Job Log Graph by User (by output color)
The data will be tallied separately by output color (black, full color) in a graph with user as the vertical 
axis, and number of pages as the horizontal axis. 

 Job Log Graph by User (by device feature)
The data will be tallied separately by device features (print, copy, fax print, scan, system sheet) in a 
graph with user as the vertical axis, and number of pages as the horizontal axis. 

 Job Log Graph by Time Zone
The data will be tallied in a graph with number of pages as the vertical axis, and time zone as the 
horizontal axis.

List
With the Job Log Analysis service, you can create the following types of lists from job log: 
 List of output jobs 
 List that includes only jobs with special character strings

Collecting Job Log from Devices
Before you can create graphs and job lists, first you need to collect job log from devices. The collected 
job log will be saved on PC with Device Setup installed. Graphs and job lists will be created from the job 
log saved on the PC. To collect job log, follow the procedure below.

1.In tree view, expand [Analysis] > [Job Log Analysis], and then select the device. 

2.Select [Collect Job Log] from the [Service] menu.
A message confirming whether you want to collect job log will be displayed. 

3.Click [Yes].
A window indicating the progress is displayed.
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Displaying Job Log in Graph
To display the job log collected in the section above in graph, follow the procedure below.

1.In tree view, select the device that has collected the job log in the above procedure.

Note
To select all the devices, expand [Job Log Analysis] in tree view, and then from the [Edit] menu, select [Select 
All]. You can also select multiple devices from list view by clicking those devices while holding the <Shift> key 
or <Ctrl>key.

2.Select [Display Job Log Graph / List] from the [Service] menu, followed by the type of the graph you 
want. Here, we select [Job Log Graph by User (by output color)].
The [Job Log Graph / List Settings] dialog box appears.

Note
When multiple devices are selected, [Job Log Graph by Time Zone] cannot be created. 

3.Set the period for the graph to display by clicking [▼ ] for [Start Date] and [End Date].
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4.Click [OK].
The job log graph by user (by output color) will be displayed.

Note
･ The displayed graph or list will be lost once the graph or list window is closed. To display the graph or list

again, repeat Steps 2 to 4.
･ You can print the graph or list by selecting [Print] from the [File] menu in the graph or list window.
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8Using Job Flow Sheet

About Job Flow Sheet
Job flow sheet describes the flow of the processing (jobs) carried out at the device, such as scan, print, 
file transfer, send e-mail, and fax.
This section explains the following items: 
 Types of job flow sheet 
 About Job Flow Sheet Editor 
 Examples of job flow sheet

Types of Job Flow Sheet
There are two main types of job flow sheet, as follows:

Job Flow Sheet for Scanned Documents
You can configure the scan resolution, output color, and recipient on the job flow sheet, and then execute 
the job flow sheet when scanning the document.
Regarding the transfer method for sending the scanned document, you can select from among SMB 
(Windows shared folder), FTP, e-mail, or mailbox. Depending on the device type, you can also print, fax, 
or send internet fax

Note
･ IP Fax (SIP) cannot be specified as the job flow transferring destination.
･ Available transfer methods vary depending on the device model you use.

Regarding the file format for transfer, you can select from among options such as DocuWorks, PDF or 
TIFF.

Transfer to a Windows shared folder

Transfer to FTP serverScan document

Send by e-mail

Store in mailbox

Print

Send by fax

Send by internet fax
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Job Flow Sheet for Documents in Mailboxes
You can configure settings such as file transferring and printing on the Job Flow Sheet, and then select 
a document in a mailbox to execute the Job Flow Sheet. 
The processing can also be executed automatically when the documents get saved in the mailbox. 
Regarding the transfer method, you can select from among SMB (Windows shared folder), FTP, e-mail, 
or mailbox. Depending on the device type, you can also print, fax, or send internet fax.

Note
･ IP Fax (SIP) cannot be specified as the job flow transferring destination. 
･ Available transfer methods vary depending on the device model you use. 

Regarding the file format for transfer, you can select from among options such as DocuWorks, PDF or 
TIFF. 

About Job Flow Sheet Editor
The Job Flow Sheet Editor enables you to create job flow sheet on its screen. Processings such as scan, 
print, and file transfer are represented by icons called feature items. By placing the feature items on the 
screen, you can create job flow sheets.

Note
Some features may not be available depending on the features of the device executing the job flow sheet.

Transfer to a Windows shared folder

Transfer to FTP server

Send by e-mail

Send by fax

Send by internet fax

Print

Mailbox

Feature items
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Examples of job flow sheet
Some examples of job flow sheet are shown below.
Example 1: Scan document, convert to DocuWorks document, and transfer to a shared folder.

Example 2: Scan document, convert to DocuWorks and PDF documents, and transfer to a shared folder.

Example 3: Once a fax document is stored in mailbox, convert to DocuWorks document, and transfer to 
a shared folder.

Example 4: Once a fax document is stored in mailbox, convert to DocuWorks document, send by e-mail, 
and print one copy.

Note
Documents that can be printed by using job flow sheet differ according to the language version of the job 
flow sheet supported by the device model. For more information, refer to the Help topic about compatibility 
of job flow sheets.

Scan File Transfer

Scan

File Transfer
(DocuWorks)

File Transfer
(PDF)

Mailbox File Transfer

Mailbox

Send E-mail

Print
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 Creating Job Flow Sheet Starting from Scan
This section explain how to create a job flow sheet to scan documents, convert to DocuWorks document, 
and then transfer to a Windows 10 shared folder.

Note
The procedure described here is applied only to those devices for which you can create and execute job flow 
sheets starting from Scan. For information on eligible device models, refer to Readme.txt.

Preparing a Shared Folder
On the PC to which you will transfer DocuWorks documents, create a shared folder for saving the 
DocuWorks documents. To do this, follow the procedure below.

1.Right-click the folder to be shared, and from the menu displayed, select [Properties]. 

2.From the properties of the folder, click the [Sharing] tab. 

3.Click [Advanced Sharing].

The [Advanced Sharing] dialog box appears. 

4.Select the [Share this folder] check box.
For [Share name], use the default name (same name as the folder).
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5.Click [Permissions].

6.Select [Everyone] in the [Permissions for {Title of folder}] dialog box.

7. In [Change] for [Permissions], select the [Allow] check box.

8.Click [OK].

9.Click ,[OK] on the [Advanced Sharing] dialog box. 

10.Click [Close] on the folder properties to close the window.
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Checking Shared Name, User Name, and Computer Name
To transfer files to the shared folder using a job flow sheet, the following information is needed: 
 Shared name of the shared folder

The name displayed in [Share name] on the folder properties when you configured sharing of the 
folder. In this example, it is the same name as the folder. 

 User name and password to log on to the PC on which the shared folder exists
You have to know the password as it cannot be checked. 

 Computer name, fixed IP address or the DNS host name of the PC on which the shared folder exists.

Note
･ Make sure to use a user name that has a password. Ifi you use a user name that does not have a password,

transferring of files to a shared folder will fail.
･ If the device on which the job flow sheet is executed and the PC on which the share folder exists are

connected to different subnets, the computer name must be registered with the WINS server.
･ IP addresses obtained dynamically via DHCP or by other means cannot be used as the destination address.

Checking the User Name

1.From the Windows [Start] menu, select [Windows System] > [Control Panel].

2.Click [User Account] > [User Account].

3.Check the user name displayed in the format of "Computer name\User name" or "Domain name\User 
name".

Checking the Computer Name

1.From the Windows [Start] menu, select [Windows System] > [Control Panel].

2.Click [System and Security] > [System].
The [System] dialog box appears.
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3.Check the computer name.

Note
When you are logged in to an Active Director domain, the computer name is displayed in a fully qualified 
format of "Computer name.Domain name".

Checking the IP Address

1.From the Windows [Start] menu, select [Windows System] > [Command Prompt].

2. In the Command Prompt window, enter "ipconfig", and then press the <Enter> key on the keyboard.
The IP address of the PC is displayed in "IP Address".

Checking the DNS Host Name

1.From the Windows [Start] menu, select [Windows System] > [Command Prompt].

2. In the Command Prompt window, enter "nslookup -querytype=ptr {IP address displayed in "Checking 
the IP Address" (P.130)}" and then press the <Enter> key on the keyboard.
The DNS host name of the PC is displayed in "name=".

Creating a Job Flow Sheet
To create a job flow sheet starting from Scan, follow the procedure below.
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1.In tree view, expand [Settings]＞ [Scanner/Fax-Specific Settings]＞ [Job Flow Sheet], and then select
the device. 

2.Select [Create Job Flow Sheet] from the [Service] menu.

3.Select the job flow sheet starting from Scan, and then click [Next]. 

Selecting this icon allows you to omit 
Step 6 for dragging and dropping the 
File Transfer feature item, but we will 
not do so in this example.
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4.Enter the job flow sheet name and click [Finish].

The Job [Flow Sheet Editor] window appears. The areas on the left, center and right of the [Job Flow 
Sheet Editor] window are called Feature Item Selection Area, Job Flow Sheet View Area, and Attribute 
Display Area, respectively.

5.Click the Scan feature item.

Feature Item Selection Area

Job Flow Sheet View Area Attribute Display Area



8 　Using Job Flow Sheet

133

6.From the Feature Item Selection Area, drag the File Transfer feature item and drop it to the Scan 
feature item.

The job flow sheet will become as follows:

7.Click the Scan feature item. On the [Settings Values] tab in the Attribute Display Area, you can 
configure settings for scanning documents, such as the output color and scan resolution.
Here, we will set the Output Color to [Full Color]. 

8.Click the File Transfer feature item.
Configure the [Settings Values] tab in the Attribute Display Area as follows: 
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1. [Transfer Method]: Use the default value, [SMB]. 
2.  [Transfer To]: Specify the computer name / IP address / DNS host name checked in the previous 

sections, and the shared folder name.
When using the computer name
Enter in the format: "\\computer name of destination\share name". 
When using the IP address
Enter in the format: "\\IP address of the destination computer\share name".
When using the DNS host name
Enter in the format: "\\DNS host name of the destination computer\share name".

Note
Clicking the button at the far right displays a dialog box for you to browse and specify the shared folder
within the network. However, the browsing will take some time. 

3. [Save In]: If there is a sub-folder inside the shared folder, you can specify the storage location of 
the file by entering the name of the folder.
We will not specify any value in this example.

Note
If there is no folder with the specified name inside the shared folder when [TIFF] or[TIFF/JPEG Auto] has
been selected for [Output File Format], a folder with this specified name will be automatically created. 

4. [Login Name]: Enter the user name checked in the previous section.

Note
Depending on the device model to be used, you may be able to specify the NT domain user name or
Active Directory domain user name as the user name. For more information, refer to the online Help topic
[Attribute Display Area for File Transfer feature] > [Login Name]. 

5. [Password]: Enter the password checked in the previous section. 
6. [Save Method]: Use the default value, [Rename New File]. 
7. [File Name]: This item is for specifying the name of the transferred file, but leave it blank as 

[Rename New File] has been selected for [Save Method]. 
8. [Output File Format]: Use the default value, [DocuWorks]. 

9.Select [Save and Exit] from the [File] menu. 
The [Save Job Flow Sheet] dialog box appears. 

(1)
(2)
(3)
(4)
(5)
(6)
(7)
(8)
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10.Click [Save to Device].

A job flow sheet number will appear in tree view when the job flow sheet has been set for the device.

Executing the Job Flow Sheet
To execute the job flow sheet starting from Scan, follow the procedure below.

Note
The procedure may differ depending on the device model in use. For more instructions, refer to the manual 
of the device.

1.Load the document on the device. 

2.Press the [All Services] button on the device control panel, and select [Job Flow Sheets]. 

3.Select the job flow sheet and start scanning the document.

See

The procedure may differ depending on the device in use. For more instructions, refer to the manual of the 

device.

 Creating Job Flow Sheet Starting from Mailbox
Here, we explain an example of how to create a job flow sheet to convert the document in the mailbox 
to a PDF document, and then transfer it to the FTP server.
You can specify the various OSs running FTP server software as the transfer destination location of the 
scanned or faxed document. The PDF documents transferred to the FTP server can be retrieved from 
within the various OSs running the FTP client software.

Note
The procedure described here is applied only to those devices for which you can create and execute job flow 
sheets starting from Mailbox. For information on eligible device models, refer to Readme.txt.

Preparing Mailbox
To create a job flow sheet starting from Mailbox, the mailbox to which the sheet is linked is needed.
To check the number of the mailbox to which you want to link the job flow sheet, follow the procedure 
below.

Note
If no mailbox has been created on the device for which you want to create job flow sheets, first create a 
mailbox by referring to "Setting Mailboxes" (P.46).
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Checking the Mailbox Number
Check the mailbox number.
You can display the mailbox number by expanding in tree view, [Settings]＞ [Scanner/Fax-Specific 
Settings]＞ [Mailbox]＞ device＞ [Mailbox List].

Preparing FTP Server
In this example, a user by the name of Masato will access the FTP server to retrieve a PDF document 
transferred from the device using the job flow sheet.
It is assumed that this user knows the user name (Masato) and password to login to the FTP server.
Besides "Masato", it is also assumed that the user for connecting the device to the FTP server (ftpuser) 
has been registered with the FTP server.

To transfer files to the FTP server using the job flow sheet, the following information is needed: 
 DNS host name or the fixed IP address of FTP server

Here, we will use "ftp.mycompany.com". 
 User name and password for device executing job flow sheet to connect to FTP server

Here, we will use "ftpuser" for user name and "e4Mva70h" for password. 
 Directory for storing file

Here, we will use "/scan_fax_doc/Masato".
It is assumed that the following access rights are set for this directory:

 Access right of ftpuser: Write
 Access right of Masato: Read / Write

In this example, to access the FTP server from the job flow sheet, do not use the actual user name 
(Masato) and password of the user but use the user name (ftpuser) and password for storing file by FTP. 
In this way, there is no need for the person that creates the job flow sheet to know the password of each 
user.

See
For information on operations such as registering user by FTP server or configuring access rights of directory, 
refer to the manual of your OS or FTP server software.

Mailbox number

From device, transfer file to FTP server
From device, access FTP server by the 
user name, "ftpuser"

FTP server User’s PCDevice for executing 
the job flow sheet

User retrieves file from the FTP 
server
User accesses FTP server by the user 
name, "Masato"
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Creating a Job Flow Sheet
To create a job flow sheet starting from Mailbox, follow the procedure below.

1.In tree view, expand [Settings]＞ [Scanner/Fax-Specific Settings]＞ [Job Flow Sheet], and then select
the device. 

2.Select [Create Job Flow Sheet] from the [Service] menu. 

3.Select the job flow sheet starting from Mailbox, and then click [Next].
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4.Enter the job flow sheet name and click [Finish].

The [Job Flow Sheet Editor] window appears. 

5.Click the Mailbox feature item.
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6.From the Feature Item Selection Area, drag the File Transfer feature item and drop it to the Mailbox 
feature item.

The job flow sheet will become as follows: 
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7.Click the File Transfer feature item.
Configure the [Settings Values] tab in the Attribute Display Area as follows: 

1. [Transfer Method]: Select [FTP]. 
2. [Transfer To]: Enter the FTP server's host name and directory for storing as explained in the 

previous section.
Here, we will use "ftp.mycompany.com/scan_fax_doc/Masato". 

3. [Save In]: Use the name specified here to create a directory for storing files, inside the directory 
mentioned above. 
We will not specify any value in this example. 

4. [Login Name]: Enter the user name checked in the previous section.
Here, we will use "ftpuser". 

5. [Password]: Enter the password checked in the previous section.
Here, we will use "e4Mva7Oh". 

6. [Output File Format]: Select [PDF]. 

8.Select [Save and Exit] from the [File] menu.
The [Save Job Flow Sheet] dialog box appears. 

9.Click [Save to Device].
A job flow sheet number will appear in tree view when the job flow sheet has been set for the device. In 
this example, we assume "2".

(1)
(2)
(3)
(4)
(5)

(6)
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Configuring the Mailbox
In this example, we configure the mailbox so that the job flow sheet is executed automatically when a 
document is stored in the mailbox. To configure the mailbox, follow the procedure below.

1.In tree view, expand [Settings]＞ [Scanner/Fax-Specific Settings]＞ [Mailbox]＞ device＞ [Mailbox
List], and then select the mailbox for executing the job flow sheet. 

2.Select [Mailbox Edit/Display] from the [Service] menu.
The [Mailbox Edit / Display] dialog box appears. 

3.At [Linked Job Flow Sheet], enter the job flow sheet number ("2" in this example) displayed in the 
previous section. Select the [Auto Start Job Flow Sheet] check box, and then click [Save to Device].

Executing the Job Flow Sheet
In this example, the job flow sheet is executed automatically when a document is stored in the mailbox. 
The document will be converted to PDF document and transferred to the FTP server.
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Creating Job Flow Sheets All at Once
“Device Setup InputTool” and Device Setup allow you to create multiple job flow sheets all at once. This 
is useful when you want to register multiple job flow sheets having different transfer destinations with a 
single device.
Device Setup InputTool is a file in the Microsoft Excel workbook format.
Batch creation of job flow sheets is performed in the following three steps: 
 Determine the base job flow sheet 
 Create an insert file using Device Setup InputTool 
 Execute a batch creation of job flow sheets using Device Setup
First, we explain how to create job flow sheets all at once using a flow diagram from start to end. Second, 
we explain these steps mentioned above individually.

Note
Device Setup InputTool allows you to create many settings all at once by using Microsoft Excel. When saving 
Device Setup InputTool containing those settings, make sure to save it in a safe way to avoid personal 
information from being compromised. For example:
･ Saving as a Zip file protected with a password
･ Saving Device Setup InputTool in a folder where access permissions are set

See
For information on device models that support batch creation of job flow sheets, refer to Readme.txt.
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Operation Flow
To create Job Flow Sheets all at once, follow the procedure below.

Start the operation

Use a template

Type of job flow sheet to be 
created all at once is in a template

Use your own created job flow sheet

Determine the base job flow sheet

Create an insert file using 
Device Setup InputTool （P.144）

Note

Step 2 in 「Executing Batch Creation Using
Device Setup」 （P.147）

Select an insert file

Job flow sheets are created all at once in Device Setup

Select the job flow sheet

The base job flow sheet is determined （P.144）

Enter the transfer destination information in an Excel 
sheet, and export it to a file.

Create an insert file

Select the base job flow sheet

Execute batch creation using Device Setup

Open the [Job Flow Sheet Batch Creation] 
dialog box

Note

Step 3 in 「Executing Batch Creation Using
Device Setup」 （P.148）

Note

Step 5 in 「Executing Batch Creation Using
Device Setup」 （P.148）
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Determining Type of Base Job Flow Sheet
You can select a base job flow sheet file to specify the transfer method and file format for the job flow 
sheet to be created all at once.
Specify the job flow sheet file in either of the following ways:

Select from Templates
Select from the following four types of templates provided for Device Setup. 
 The scanned document file is transferred to a shard folder (Transfer method: SMB; file format: 

DocuWorks) 
 The scanned document file is transferred to a shard folder (Transfer method: SMB; file format: PDF) 
 The scanned document file is sent by e-mail (File format: DocuWorks) 
 The scanned document file is sent by e-mail (File format: PDF)

Selecting from Job Flow Sheets
A job flow sheet file can be created by selecting “Export Job Flow Sheet” from the [Service] menu with 
a configured job flow sheet selected.  The job flow sheet file created under the following conditions can 
be selected as a template. 
 Only one File Transfer Feature item (SMB) is included 
 Only one Send E-mail Feature item is included 
 Only one File Transfer Feature item (SMB) and only one Send E-mail Feature item are included

Note
If multiple File Transfer Feature items (SMB) or Send E-mail Feature items are included, an error occurs. No 
error occurs even if a Mailbox, Fax, Internet Fax or Print feature item is included in a job flow sheet. However, 
the attributes of these feature items (e.g. recipient’s fax number) cannot be changed in an insert file.

See
For more information on conditions, refer to the Help topic “Creating Job Flow Sheets All at Once”.

Creating an Insert File
Create an insert file using Device Setup InputTool. “Device Setup InputTool - Job Flow Sheets.xls” is 
composed of the following Excel sheets. 
 File Transfer (SMB)

Used when the scanned file is transferred (SMB) to a shared folder of Windows. 
 Send E-mail

Used when the scanned file is sent by E-mail. 
 File Transfer (SMB) + Send Email

Used when the scanned file is transferred (SMB) to a shared folder of Windows as well as is sent by 
E-mail.

Important
Device Setup exports the file in a format unique to itself. Do not edit the file using other applications.

Note
･ Information on the job flow sheets you change at the device or on Device Setup are not reflected in Device

Setup InputTool. Therefore, the content in the Excel sheet may be different from the latest settings of the
device.
･ The extension of the exported insert file is “mb2” (format unique to Device Setup).
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The following procedure explains how to create an insert file for multiple job flow sheets with different 
transfer destinations using the [File Transfer (SMB)] sheet.

1.From the Windows [Start] menu, select [FUJIFILM] >[Device Setup InputTool].
The [InputTool] window appears. 

2.Double click the “Device Setup InputTool - Job Flow Sheets.xls” file.

Note
･ Device Setup InputTool uses macros. To use this tool, you need to specify [Medium] or less for the security

level of Microsoft Excel. When [Medium] is specified, a message confirming the execution of a macro is
displayed. Click [Enable Macros].
･ Double clicking “Usage of Device Setup InputTool.txt” displays the additional information and restrictions

for Device Setup InputTool. 

See
For information on the Excel versions supported by Device Setup InputTool, refer to "Required System 
Environment" (P.19).
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3.Select the sheet to use, and enter insert data for the job flow sheet you want to create. Enter transfer 
destinations for the job flow sheet, one destination per row. Up to 1000 destinations can be entered. 
After completing entering the data, select [End of Data] in the [Data Processing] column on the last 
row you entered.

Note
You can check if the values entered so far in the cells are correct by clicking [Check Data]. This check is the 
same as the one performed when you click [Export Data] in Step 4. 

See
For information on what information you need to enter in each of the cells, refer to the Help displayed when 
you click the header cell.

4.Click [Export Data].
At this point, the content in the cells are verified. If a value is incorrect, the error cell is highlighted, and 
the error message appears. 
Enter the correct value, and then click [Export Data] again.
If there is no error, the [Save As] dialog box appears. 

5.Specify the filename and storage location, and then click [Save].

The [Data Export] message appears. 

6.Click [OK].
The insert file with “mb2”extension (format unique to Device Setup) is created in the specified location. 
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The original workbook provided for the product cannot be overwritten. To save the data you entered, 
select [Save As] from the [File] menu, and specify a file name.

Note
Save the file in a folder where access permissions are set, which is located in a different place than the Device 
Setup installation folder.

7.Select [Close] from the [File] menu.
Device Setup InputTool is exited.

Executing Batch Creation Using Device Setup
To execute a batch creation of job flow sheets using Device Setup, select a base job flow sheet file, and 
import the insert file exported by Device Setup InputTool.
Here, we use a template “The scanned document file is transferred to a shared folder (Transfer method: 
SMB, File format: DocuWorks” as an example.

1.In tree view, expand [Settings]＞ [Scanner/Fax-Specific Settings]＞ [Job Flow Sheet], and then select
the device. 

2.Select [Job Flow Sheet Batch Creation] from the [Service] menu.
The [Job Flow Sheet Batch Creation] dialog box appears. 
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3.Select [Select from template] from [Select the base Job Flow Sheet].
Next, select [Scanned document: File Transfer to shared folder (Transfer Method: SMB, File Format: 
DocuWorks)] by clicking [▼ ].

Note
When selecting a job flow sheet file, select [Select any Job Flow Sheet (xml file)]. Next, click [Select File] to 
select the file from the storage location.

See
For information on conditions under which to select a job flow sheet, refer to "Selecting from Job Flow 
Sheets" (P.144). 

4.Click [Select File] in [Select plug-in information].
The [Select plug-in information] dialog box appears. 

5.Browse to the location into which the insert file was exported in the previous section.

Select the insert file (“mb2” extension), and then click [Open]. The [Information contents confirmation] 
dialog box appears. 
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6.Check if there is no wrong information on the job flow sheet to create.
After checking the information, click [Yes].

This returns you to the [Job Flow Sheet Batch Creation] dialog box.

7.Click [OK].
The [Save Job Flow Sheet] dialog box appears. 

8.Click [OK].

A confirmation message appears. 
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9.Click [OK].

The job flow sheets are created all at once in the selected device.

See
At this point, the job flow sheets have not been set on the device. Set them on the device, as needed. For 
instructions, refer to "Reflecting Your Settings in Devices" (P.102).

Notes on Job Flow Sheet
This section explains some supplementary information on job flow sheet.

Devices That Support Job Flow Sheet

See
For information on device models that support job flow sheet, refer to Readme.txt.

Number of Feature Items That Can be Added to Job Flow Sheet
Besides the Control Panel feature item, you can add up to 31 feature items.
The Control Panel feature item represents the start of the job flow sheet and must always be in front of 
the job flow sheets. It cannot be added or deleted.

Control panel feature item
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Sequential and Parallel Processing of Job Flow Sheet
The types of job flow sheet processing are as follows.

Sequential Processing
Job flow sheets arranged in a row are called sequential processing.

The characteristics of executing sequential processing are as follows: 
 Once the previous processing is done, the next processing begins. As such, the processings will be 

executed in the order of the feature items. 
 If an error occurs during a processing of the job flow sheet, all the processings that follow will be 

interrupted.

Parallel Processing
Job flow sheets in branches are called parallel processing.

In parallel processing, only one location is created in the job flow sheet. You cannot add any more feature 
item after the parallel processing. The characteristics of executing parallel processing are as follows: 
 The order of executing the processing is not fixed. 
 If an error occurs during a processing of the job flow sheet, the remaining processing will be 

interrupted.

Note
When error occurs in either the sequential processing or parallel processing of job flow sheets set with error 
notification, the remaining processings will be executed. For more information on error notifications, refer to 
Help.
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When Job Flow Sheet is Not Executed Correctly
When a job flow sheet is not executed correctly, investigate as follows: 
 Using the Job Flow Sheet Editor, display the job flow sheet settings, and check if the settings of the file 

destination, such as PC, user name, e-mail address and mailbox number are correct. However, there 
is no way to display the password set in the job flow sheet. 

 Use the job checking screen of the device to check the error code of the job.

Note
･ The result of executing the job and error codes are also displayed on the Internet Services Job screen.
･ You can also check the error codes from the Error History Report to be printed by the device.

See
･ The manual of the device for details on checking errors of the device.
･ For information on how to troubleshoot issues, refer to "Problems of Job Flow Sheet Service" (P.163).

Resend Feature When Job Flow Sheet Failed
You can configure whether to retry the sending when file transferring, sending e-mail, or sending 
internet fax has failed.

1.Click the feature item that you set to resend. In this example, we click the File Transfer feature item.

2.Configure the [Settings Values] tab in the Attribute Display Area as follows:

1. [Resend Attempts]: Select [On]. 
2. [Number of Retries]: Specify the number of retries for the sending. The range is from 1 to 5 times. 
3. [Interval (Seconds)]: Specify the interval between retries in units of seconds. The range is from 30 

to 300 seconds. 

(2)
(1)

(3)



Appendix

153

Appendix
About Encrypted Password

Some device models can send passwords, such as those for user details and mailbox, to Device Setup in 
an encrypted format. Password encryption can prevent eavesdropping on the network and password 
referencing by third parties.
Here, we explain how Device Setup processes encrypted passwords.

Device Models Supporting Encrypted Password Retrieval
For information on device models from which Device Setup can retrieve encrypted passwords, refer to 
Readme.txt.

Types of Passwords to be Retrieved
Types of passwords that can be retrieved in an encrypted format on Device Setup are as follows:

Retrieving/Setting Password
Here, we explain how Device Setup retrieves encrypted passwords from the device and sets the 
retrieved passwords to the device.

Retrieving Password
Devices encrypt passwords using the encryption key for confidential data, and send the encrypted 
passwords to Device Setup. Device Setup retrieves encrypted passwords.

Service Password Type

Basic Information ･ POP3 server settings password
･ SMTP server settings password

Access Permissions ･ User password
･ Guest password for Login to Remote Accounts

Mailbox Mailbox password

Address Book/Contact
Information

･ Mailbox password for fax settings
･ F code communication password for fax settings
･ Login user password for server settings

Encrypt passwords with encryption 
key for confidential data, and send 
them to Device Setup Store encrypted 

passwords

Device SetupDevice
Encryption key for 
confidential data
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Setting Password
The encrypted passwords retrieved from the device are sent to the device intact.
The device decodes the passwords using the same key as the one used for encryption. If the encryption 
key for confidential data has been changed, the device cannot decode the passwords. In that case, the 
passwords will not be set to the device.

Note
･ Encrypted passwords are sent to devices intact only when they have not been changed on Device Setup.
･ Decoding passwords is to convert the encrypted passwords into their original state before the encryption.

Editing Passwords
To edit a password on Device Setup, click [Edit Password] on each dialog box. This allows you to enter 
the password in [Passcode/Password] and [Confirm Passcode/Password].
If the password has been encrypted, a lock icon is displayed on the right of [Passcode/Password].
The lock icon will disappear when you click [Edit Password] and change the password.

Copying Attributes and Handling of Passwords
When copying user details, mailbox, or address book/contact information of a device that supports 
password retrieval on Device Setup and pasting it to another device, the content of passwords pasted 
differs according to the device type at the copy destination.

For a Device Model That Supports Password Retrieval
The encrypted passwords will be pasted intact. However, they will be actually set on the device intact 
only when the encryption key for confidential data is the same.

For a Device Model That Does Not Support Password Retrieval
The passwords will be pasted as blank. Specify them again.

Send the encrypted 
passwords to the device intact

Decode passwords with the 
same key as the one

Device SetupDevice
Encryption key for 
confidential data
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Changing Device Models and Handling of Passwords
In the [Device Identity Info] dialog box, if you change from a device model that supports password 
retrieval on Device Setup to another device model that does not, the [Password Processing 
Confirmation] dialog box will appear. Confirm the message in the dialog box, and then select whether to 
change the device model with the passwords left blank or to cancel changing the device model.

If the device model is changed, the passwords will be set as blank. Specify them again.

Changing Encryption Key for Confidential Data
Devices encrypt passwords using the encryption key for confidential data, and send the encrypted 
passwords to Device Setup. Also, when the encrypted passwords are set to devices from Device Setup, 
the devices decode the passwords using the same key as the one used for the encryption. You can 
change the encryption key for confidential data on Device Setup.

Notes on Changing Encryption Key for Confidential Data
If the encryption key for confidential data has been changed, the devices cannot decode the passwords. 
In that case, the attributes (such as user details, mailbox, and address book/contact information) that 
contain the encrypted passwords cannot be saved to the devices.
When the attributes that contain the encrypted passwords cannot be saved to the device due to the 
change of the encryption key, set the old key before the change to the device again. Remember the old 
and new keys when changing the encryption key for confidential data.
In addition, if you have set attributes only in Device Setup and have not saved them to devices yet, save 
the attributes to the devices before changing the encryption key.

Note
When you change the encryption key for confidential data for the first time, the default encryption key is 
"factory preset encryption key". For information on the factory preset encryption key, refer to the manual of 
the device.

Notes on Exporting / Importing Device Setting File
Changing the encryption key for confidential data will affect the exporting / importing of the device 
setting file. In the setting file exported before changing the encryption key, the attributes (such as user 
details, mailbox, and address book/contact information) that contain the encrypted passwords cannot 
be saved to the device again. In this case, set the old encryption key before the change to the device as 
mentioned above. After that, set the setting file to the device again.

See
For information on exporting / importing the device setting file, refer to "Exporting Device Settings to a File" 
(P.104).
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Changing Encryption Key for Confidential Data
You can change the encryption key for confidential data on Device Setup. The encryption key for 
confidential data cannot be retrieved from the device.

1.In tree view, expand [Settings] ＞ [General Device Settings] ＞ [Basic Information], and then select
the device to be configured.

2.Select [Encryption Key for Confidential Data Setup] from the [Service] menu.
The [Encryption Key for Confidential Data Setup] dialog box appears.

3.Enter the encryption key.

4.Click [Save to Device].
A dialog box appears to confirm if you want to apply the settings.

5.Click [Yes].
The settings will be applied to the device.

Note
The encryption key for confidential data will not be applied to the device even if you select [Save Attributes 
to Device] from the [Edit] menu. 
Configure the setting in the [Encryption Key for Confidential Data Setup] dialog box.



Appendix

157

Troubleshooting
This section explains the possible causes and their solutions for problems that may occur when you are 
using Device Setup.

Cannot Start Device Setup

Device Cannot Be Found

Problem Cause Solution

The following error is displayed
when you enter the password at
startup:
"Login fails."

The password is incorrect. Enter the correct password. The
password immediate l y  a f ter
installation is: "x-admin".
If you have forgotten the password
after changing it, uninstall and then
reinstall Device Setup.

See
"Uninstalling Device Setup"
(P.27)and "Installing Device
Setup for the First Time"
(P.23)

The following error is displayed at
startup:
"Administrator rights are required."

You do not have administrator
rights.

Log in to the PC as a user of the
Administrators group, and then start
Device Setup.

An error similar to the following is
displayed at startup:
"Job flow sheet IDs do not exist in
older versions, so the job flow sheets
cannot be linked with mailboxes.
Therefore, attribute values linking
mailboxes with job flow sheets are
handled as follows:
･ "Linked Job Flow Sheet" will be set 

to "None".
･ The [Auto Start Job Flow Sheet] 

check box will be deselected.
Are you sure?
Clicking "No" will exit Device 
Setup."

The job flow sheets do not have IDs,
so  l ink  in format ion  between
mailboxes and job flow sheets
cannot be taken over to the newer
version of Device Setup.

Job  f low sheets  c reated  in
CentreWare Easy Admin 2.0.0 /2.0.1
do not have IDs.
Select "Yes", start Dev ice Setup, and
retrieve the attribute values from
the device again. Then, from Job
Flow Sheet Editor, open and save the
job flow sheets that do not have IDs.
This will attach IDs to them.
Next, double-click the mailbox to
open the [Mailbox Edit/Display]
dialog box. Select the job flow sheet
in [Linked Job Flow Sheet].

Problem Cause Solution

After searching for a device to add,
the device cannot be found on the
network.

The device does not support Device
Setup.

Device models that do not support a
service from Device Setup cannot be
added to the service.
For information on the supported
device models, refer to Readme.txt.
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Cannot Retrieve / Set Attributes From Device

After searching for a device to add,
the device cannot be found on the
network.

The device is in a different subnet
from the PC where Device Setup is
installed.

If the device is in other subnet, you
have to specify the subnet address
when searching for the device. Click
[Search Condition] on the [Search
and Add Device] dialog box, and
then specify the subnet address
before searching for the device
again.

See
Step 4 in "Searching the
network for devices and
registering them" (P.33) 

The device setting is wrong. Check the network setting 
of the device.

See
"Essential Settings for 
Communicating with 
Devices" (P.20)

The device is not turned on. Turn on the device, wait for about
two minutes, and then search for the
device again. Depending on the
configuration of your device, the
waiting time may be more than two
minutes.

Af ter  search ing for  a  dev ice
specifying the subnet address, the
device cannot be found on the
network.

By the setting of the network device,
the  communicat ion  used for
searching devices is prohibited.

Allow the broadcast communication
to another subnet ,  or register
devices one by one without using
searching devices.

Problem Cause Solution

An error message appears when you
try to retrieve / set attribute values.

The system administrator ID and
password settings of the device do
not match those settings on Device
Setup.

The system administrator ID and
password of the device may have
been changed at the device. Select
[Device Communication Settings]
from the [Edit] menu to display the
[Device Communication Settings]
dialog box, and then change the
system admin is t rator  ID  and
password settings on Device Setup
to match the settings on the device.

See
"Configuring Sett ings to
Communicate  wi th  the
Device" (P.38)

Problem Cause Solution
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An error message appears when you
try to retrieve / set attribute values.

The  dev ice  mode l  name and
software version set on Device
Setup are different from those set on
the actual device.

On Device Setup, select the device
from which to retrieve / for which to
set attribute values. Select [Device
Identity Info] from the [Edit] menu
to display the [Device Identity Info]
dialog box, and then set the correct
device model name and software
version.
You can check the software version
of the device on its control panel. On
the [Machine Status] screen, select
[Machine Information] and check
[Software Version]. Or, you can also
print out the System Settings List of
the device to check.

The device setting is wrong. Check the network setting of the
device.

See
"Essent ia l  Set t ings  for
Communicat ing  with
Devices" (P.20)

The device is in operation. Try again after the device has
completed its operation.

The device is not turned on. Turn on the device, wait for about
two minutes, 
and then try again. Depending on 
the configuration of your device, 
the waiting time may be more than
two minutes.

The encryption key for confidential
data as of when Device Setup
retrieved attributes from the device
is not identical to the current key on
the device. The encryption key for
confidential data may have been
changed.

Revert  the encrypt ion key for
confidential data set on the device
to the old key before the change.

See
"Changing Encryption Key for
Confidential Data" (P.155)

After setting or deleting device
attribute values from Device Setup,
a message indicating the following is
displayed on the device control
panel, and no other operations can
be done except for rebooting the
device:
“Current settings must be reset as
registered data has been updated
by an operation from an external
machine.”

The device control panel is being
used.

Reboot  the device.  Sett ing or
deleting of device attribute values
from Device Setup must be done
only when the device control panel
is not being used.

Problem Cause Solution
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Problems of Basic Information Service

Problems of Access Permissions Service

Any information other than basic
information (e.g. address book)
cannot be retrieved.

Device Setup or the device has
incorrect settings.

If you cannot retrieve information
with Device Setup,  check the
following:
･ Ports for communicating with 

Device Setup ([UDP] for the 
[SNMP] port, the [SOAP] port, and 
the [Internet Service] port) are 
enabled at the device
･ The User ID and password 

configured in Device Setup match 
the ones set on the device
･ The SMNP/SOAP port numbers 

configured in Device Setup match 
the ones set on the device
･ The community name for SMNP 

v1/v2, or the SNMP v3 settings 
configured in Device Setup match 
the ones set on the device
･ The firewall configuration of the 

security software application 
installed on the PC where you are 
using Device Setup does not block 
the ports used in Device Setup

Problem Cause Solution

[Other Detailed Settings] does not
open.

The Internet Service (HTTP) port of
the device is not enabled.

Check that the Internet Service
(HTTP) port is enabled at the device.
For information on how to enable
ports, refer to the manual of the
device.

Problem Cause Solution

User cannot be added to [Add User
Details].

The Login Setup /Accounting Mode
setting of the device is wrong.

To use the Login Setup / Accounting
Mode function, enable the login /
accounting settings in the [Login
Setup / Accounting Mode] dialog
box .

See
"Configuring Login Setup /
Accounting Mode for the
Device" (P.111)

The number of users that can be
stored in NVM (nonvolatile memory
of device) is exceeded.

If [Login to Network Accounts], [No
Login  Requi red/Network
Accounting], or [Login to Local
Accounts/Network Accounting] is
selected in the [Login Setup /
Accounting Mode] dialog box,
change [Store User Details] to [Hard
Disk].

Problem Cause Solution
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The [Import User Permissions]
menu is grayed out, so batch input
files cannot be imported into Device
Setup.

The Login Setup /Accounting Mode
setting of the device is wrong.

To import a batch input file into
Device Setup, the device must be
set to [Login to Local Accounts],
[Login to Local Accounts/Network
Accounting], [Login to Network
Accounts],  [Log in  to  Loca l
Accounts/ Network Accounting] or
[No Log in  Requi red/Network
Accounting].
With the device selected, select
[Login Setup / Accounting Mode]
from the [Service] menu and make
settings.

See
"Configuring Login Setup /
Accounting Mode for the
Device" (P.111)

Importing a batch input f i le in
[Import User Permissions] causes
an error similar to the following:
"The User Permissions fi le has
invalid attributes."

The Login Setup /Accounting Mode
setting of the device is wrong.

To import a batch input file created
from “Device Setup InputTool - User
Permissions.xls” into Device Setup,
the login setting for the device must
also be set  to [Login to Local
Accounts],  [Log in  to  Loca l
Accounts/Local Accounting], [Login
to Network Accounts], [Login to
Loca l  Accounts/  Network
Accounting] or [No Login Required/
Network Accounting] according to
the setting on the sheet.
With the device selected, select
[Login Setup / Accounting Mode]
from the [Service] menu and make
settings.

See
"Configuring Login Setup /
Accounting Mode for the
Device" (P.111)

After  the Access  Permiss ions
settings have been set and enabled
for a device, the device cannot be
accessed in any way.

The access permitted IP address is
not set on the device.

Disable the access permission
settings at the device control panel.
Ensure  that  you  add access-
permitted IP addresses before
enabling the IP access restriction. If
you enable the IP access restriction
when there is no access-permitted
IP address designated, any user
cannot access the device using TCP/
IP in any way.

Problem Cause Solution
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Problems of Mailbox Service

Problems of Address Book/Contact Information Service

Problem Cause Solution

Job flow sheet cannot be linked to
mailbox.

The job flow sheet is not correctly
specified.

Double-click the mailbox to link to a
job flow sheet in list view. Select the
job flow sheet from [Linked Job Flow
Sheet] in the [Mailbox Edit/Display]
dialog box.

See
"Configuring the Mailbox"
(P.141)

There is no job flow sheet starting
from Mailbox.

Create a job flow sheet starting from
Mailbox with the Job Flow Sheet
service.

See
"Creating Job Flow Sheet
Start ing  f rom Mai lbox"
(P.135)

The Job flow sheet was created in
Easy Admin 2.0.0/2.0.1, so it does
not have IDs.

Job flow sheets created in Easy
Admin 2.0.0 /2.0.1 do not have IDs.
Therefore, link information between
job flow sheets and mailboxes was
lost when you upgraded to Device
Setup.
In this case, open and save the job
flow sheet in Job Flow Sheet Editor.
Then, link the job flow sheet to
mailboxes using the [Mailbox Edit/
Display] dialog box.

Problem Cause Solution

Registering with devices using the
address book/contact information
service fails.

With the Speed Dial Expansion Kit is
not installed on the device, you are
at tempt ing to  reg ister  more
addresses than the maximum
number allowed for the device 

Purchase the Speed Dial Expansion
Kit.
For information on the maximum
number of addresses that can be
registered with the device, refer to
the manual of the device.
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Problems of Job Flow Sheet Service
Problem Cause Solution

Created Job Flow Sheets are not
displayed on the device control
panel.

There is no job flow sheet starting
from Scan.

Create a job flow sheet starting from
Scan using the Job Flow Sheet
service. Job Flow Sheets starting
from Mailbox are not displayed on
the device control panel.

See
"Creating Job Flow Sheet
Starting from Scan" (P.127)

The user logging in to the device is
not the owner of the job flow sheet
when the Login Setup feature is
used at the device.

Log in to the device as the owner of
the job flow sheet.

Password or PIN code is requested
on the device control panel each
time attempting to run a job flow
sheet.
And, when attempting to run a job
f low sheet  that  i s  executed
automatically with mailboxes linked
it, the processing fails.

The setting for displaying password
or PIN code on the device control
panel is enabled.

On the [Details] tab in Job Flow
Sheet Editor, set [Panel Display] for
password to [Disable].
Enabling the setting for displaying
password or PIN code on the device
control panel disables the preset
password for job flow sheets.

When attempting to import job flow
sheets exported to device setting
files into Device Setup, an error
message appears.

You device is not compatible with
job flow sheet.

Job flow sheets exported from a
device that is not compatible with
job flow sheets cannot be imported.
There is no compatibil ity from
ApeosPort models to DocuCentre
models.
For more information, refer to the
Help topic about compatibility of job
flow sheets.

When attempting to run a job flow
sheet imported from a file, the
processing fails.

Password information is not set for
the job flow sheet.

When you export job flow sheets
from Device Setup to files, the
following password are deleted:
Also, when you import the files to
Device Setup and set them to a
device, those job flow sheet will not
work.
･ PIN code/password for fax settings 

/ mailboxes
･ After importing the file of job flow 

sheet for transfer/send destination 
passwords, open it in Job Flow 
Sheet Editor, and check whether 
some feature items requiring 
password or PIN code are 
included.
If there are any items requiring 
password or PIN code, set them in 
Job Flow Sheet Editor.
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[Job Flow Sheet Batch Creation] is
grayed out, so insert files cannot be
imported into Device Setup.

The device does not support the
[Job Flow Sheet Batch Creation]
feature.
For information on device models
that support batch creation of job
flow sheets, refer to Readme.txt.

To create job flow sheets for a device
that does not support the [Job Flow
Sheet Batch Creation] feature,
create them one by one in Job Flow
Sheet Editor.
Alternatively, create a job flow sheet,
copy it as many as you want, and
edit attributes one by one in Job
Flow Sheet Editor.

See
"Creating a Job Flow Sheet"
(P.130)

When attempting to copy/paste a
job flow sheet to different device
models, it cannot be selected from
the menu.

You device is not compatible with
job flow sheet.

Job flow sheets cannot be copied/
pasted to device models that are not
compatible with job flow sheets.
There is no compatibil ity from
ApeosPort models to DocuCentre
models.
For more information, refer to the
Help topic about compatibility of job
flow sheets.

Problem Cause Solution
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Running a job flow sheet containing
file transfer at a device results in an
error.

The job flow sheet contains wrong
settings. Or, there are some issues in
the transfer destination settings.

Check the error code displayed in
the Job Status window of the device,
and refer to the manual of the device
for solutions. Some of error codes
you may encounter are:
Error code: 016-782
The "login name" or "password" to
access the transfer destination may
be incorrect.

See
For SMB transmission
"Checking Shared Name,
User Name, and Computer
Name" (P.129)
(4)  and (5)  o f  s tep 8
of"Creating a Job Flow Sheet"
(P.130)
For FTP transmission
"Prepar ing  FTP Server "
(P.136)
(4)  and (5)  o f  s tep 7
of"Creating a Job Flow Sheet"
(P.137)

Error code: 016-784
･  For SMB transmission

In the permission settings for
shared folders, the [Allow] check
box for [Change] may not be
selected, or items in [Deny] may
be selected. By default, share
fo lders  are  ass igned read
permiss ion  on l y.  Therefore ,
devices cannot write to share
folders. Give change permission to
the shared folders.
･  For FTP transmission

Appropriate permissions to access
the  f i le  s torage  dest inat ion
directory may not be set. Give
[Write] access to users who will
log in to the storage destination
directory.

See
"Prepar ing  FTP Server "
(P.136)

Problem Cause Solution
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Running a job flow sheet containing
file transfer at a device results in an
error.

The computer name and the DNS
host  name of  the  t ransfer
destination cannot be resolved.

Replace the computer name and the
DNS host name of the transfer
destination, set in the job flow sheet,
with IP addresses.
Example: "\ \ m y p c 0 1 s a m p l e 」
⇒ \\192.168.110.154\sample"
Make sure to enter the IP address
with single-byte numbers.

See
For SMB transmission
(2) of step 8 of"Creating a Job
Flow Sheet" (P.130)
For FTP transmission
(2) of step 7 of"Creating a Job
Flow Sheet" (P.137)

I f  the  prob lem pers ists  a f ter
following these steps, contact your
network administrator to check
whether  the  communicat ion
between the device and transfer
destination can be established.

Running a job flow sheet containing
e-mail or internet fax at a device
results in an error.

The settings for using e-mail or
internet fax are not configured
correctly.

Check the settings of the device.

See
"Essential Settings for E-mail
/  Internet  Fax  /  Fi le
Transferring" (P.20)

E-mail messages sent via a job flow
sheet does not reach the recipients.
(Bounced emails are returned.)

･ The specified e-mail address does 
not exist.
･ At sending, the recipient's inbound 

mail box exceeds the maximum 
allowed capacity.
･ there is any problem in the 

outgoing mail server (SMTP 
server).

Check whether the email addresses
set in the job flow sheets are correct.
Change the upper limit of outgoing
e-mails size at the device, or lower
the scanning resolution.
I f  the  prob lem pers ists  a f ter
following these steps, contact your
network administrator.

Problem Cause Solution
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Problems of Job Log Analysis Service
Problem Cause Solution

The following error is displayed
when co l lect ing  job  log:
"Job log cannot be collected. For
details, refer to the operation log
file. For details on operation log file,
refer to Help."

The device setting is wrong. Check the network setting of the
device.

See
"Essent ia l  Sett ings  for
Communicat ing  wi th
Devices" (P.20)

The device is in operation. Try again after the device has
completed its operation.

The device is not turned on. After switching on the power of the
device, wait a while before operating
the device again.

Insufficient hard disk free space in the
PC installed with Device Setup.

Increase the hard disk free space of
the PC.

The folders or files beneath the folder 
where Device Setup is installed, by 
default, (drive with system folder):
\Program Files(x86)\FUJIFILM\
Device Setup\Data Files\
Plugin\DeviceAnalysisJob”
 does not have write access.

Set write-access to the folder or file
mentioned on the left.
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Glossary

•Access permissions
An act to configure settings for login /
accounting on a device per user. It also can
be used to  restr ict  PCs and e-mai l
addresses that have access to devices.

•Access-permitted domain
An e-mail originating domain from which
data  t ransmiss io n  to  the  dev ice  i s
permitted or denied, based on the access
permissions feature.

•Access-permitted IP address
An originating IP address from which data
transmission to the device is permitted,
based on the access permissions feature.

•Account ID
An attribute for users that is used for
network login / accounting. In general, a
project code or department code is used as
the account ID. ApeosWare Management
Suite enables the accounting and usage
restrictions of devices per account ID.

•Accounting
A feature to manage the usage status of
each feature of the device by user.

•Address Book
Information that stores speed dial numbers
/ address numbers.

•Administrators group
in  Microsof t  Windows,  a  gro up  o f
administrators with rights to all operations.

•ApeosWare Management Suite
A software application to manage and
analyze document volume by retrieving
various output control logs from multi-
functional machines and printers provided
by FUJIFILM Business Innovation Corp.

•Attribute
An attribute is a piece of information that a
device has. Specially, a device's settings
(e.g. enabled port or information about
administrator) and registered data (e.g.
user,  mailbox, address book/contact
information, or job flow sheet) are all
attributes of the device.

•Authentication
A feature for limiting the use of the device
to users registered with the device. The
users need to enter the User ID and
password when using the device.

•Batch input file
A file exported by Device Setup InputTool
and used when mult ip le mai lboxes,
address book/contact information, and
access permissions etc. are created all at
once. The extension is "mb3” to “mb10”.

•Contact Information
Information on recipients saved with their
attributes.

•Context menu
A menu that is displayed when you right-
cl ick the mouse while the pointer is
positioned on a service in tree view.

•Device Setup InputTool
A tool to create a configuration file required
when mailboxes, access permissions,
address book/contact information, or Job
Flow Sheets are created all at once using
Device Setup.

•Device settings file
A fi le for storing information on the
registered devices and attributes of
services (e.g. mailbox, address book/
contact information) that work with Device
Setup. The data will be saved on a service-
by-service basis. The file extension is
"mb1" (format unique to Device Setup).
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Appendix

•Encryption key for confidential data
Device Setup can retrieve passwords, such
as those for a address book/contact
information and mailbox, from some device
models. The passwords are retrieved in an
encrypted format. The key used for this
encryption is the encryption key.

•Fax comment
Comments used in cover page for Internet
Fax.

•Folder selector
A service to distr ibute received fax
documents to the mailboxes based on the
sender's telephone number, the receiving
number, the remote ID or the receiving line.

•FTP
A protocol for transmitting files from one
device to another using TCP/IP.

•Insert file
A f i le  exported us ing Device  Setup
InputTool to create multiple job flow sheets
all at once. The file extension is "mb2"
(format unique to Device Setup).

•Internet fax
Fax that does not go through a telephone
line (public line and ISDN line) like the
general fax transmission but sent through
the company internal network and Internet
as a mail (attached TIFF document).

•Internet Services
A service provided by FUJIFILM Business
Innovation Corp. In a TCP/IP-enabled
environment, it enables you to display
device or job status or change the settings
via a web browser.

•IP fax (SIP)
Fax transmitted using SIP protocol, via
Internet or a telephone line The destination
is specified by a telephone number or
SIPURI (e.g.1111@example.com).

•IPv4 address
A 32-bit  IP address.  The address is
separated into four 8-bit  groups by
periods. Each 8 bit is described in decimal
(from 0 to 255).

•IPv6 address
A 128-bit IP address. The address is
separated into eight 16-bit groups by
colons. Each 16 bit is described in four-
digits hexadecimal.

•Job flow sheet
Data that descr ibes the f low of  the
processing (jobs) carried out at the device,
such as scan, print, send e-mail, and fax.

•Job log
Tallied data on the operation state of the
device. Items to be tallied include total
print pages; the number of transmitted fax
and internet fax pages; the number of
times of scanning; and the number of
printed and copied pages.

•List view
The area on the left of the Device Setup
window. The devices managed by Device
Setup and their attributes are displayed in
a list format.

•Local accounting
An act to check usage such as accumulated
processed pages per user on the device.
The tallied results cannot be viewed from
Device Setup, the device control panel, and
Internet Services.

•Login to local accounts
An act to authenticate the user by using the
user details registered with the device.
User details can be managed from Device
Setup, the device control panel, and
Internet Services.
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•Login to remote accounts
An act to authenticate the user by using the
user  deta i l s  reg is tered  w i th  the
authentication server. User details cannot
be managed from Device Setup, the device
control panel, and Internet Services.

•Mailbox
A storage area the device has for storing
scanned and faxed documents.

•Mailbox number
A number allocated to the mailbox for
storing scanned and faxed documents.

•Name resolution
An act to determine IP addresses from
names such as computer names and host
names allocated to computers and devices
on the network.

•Network accounting
An act to check usage such as accumulated 
processed pages per user using 
ApeosWare Management Suite. The tallied 
results cannot be viewed from Device 
Setup, the device control panel, and 
Internet Services.

•NVM (NV memory)
Non-volatile memory that can retain the
settings of devices even if the device is
turned off.

•POP
An acronym of Post Office Protocol. A
protocol for receiving e-mails from the
server storing e-mails. Widely used for
receiving e-mails.

•Protocol
A standard that defines a method of
communication and others. Sender and
recipient must use the same protocol in
order to communicate.

•Service
A plug-in module with device managing
features provided by Device Setup.

•SMB
An acronym of Server Message Block. A
protocol used for sharing between files and
printers on the network between Windows.

•SMTP
An acronym of Simple Mail  Transfer
Protocol. A protocol for transferring e-mails
received from the e-mail server to the e-
mail server of the recipient. Generally used
for sending e-mails.

•SOAP
An acronym of Simple Object Access
Protocol. A protocol used for transmitting
among objects (e.g. general computer data
and services) based on XML via the
network.

•SSL
An acronym of Secure Sockets Layer. A
security protocol developed by Netscape
to encrypt data transferred over the
network.

•Time server (NTP server)
Server that correctly adjusts the internal clock by
obtaining the correct time from GPS or atomic
clock via the network. If there is a time server
that can be connected by NTP protocol, Device
Setup can referred to it to set the internal clock
of the device.

•Tree view
The area on the left of the Device Setup
window. Device Setup services, the devices
managed by the services,  and their
attributes are displayed in a tree format.
The top item in tree view is [Device Setup].
Click [+] or [-] to expand or collapse the
tree.

•User ID
ID for identifying individual device users.
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